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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i
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Introduction

1  Introduction

Overview of Implementing Talent Review and Succession
Management  
This guide explains the setup and implementation tasks of Oracle Fusion Cloud Talent Review and Succession
Management.

Using the tasks described in this guide, you can do these configurations:

• Configure Talent Review settings

• Create Talent Review templates

• Manage potential assessments

• Set up talent review meetings

• Configure Succession Management lookups

Oracle Talent Review and Succession Management is part of the Workforce Development offering of Oracle Fusion
Cloud Human Capital Management. To start an implementation of Oracle Fusion Cloud Human Capital Management,
you need to opt into the offerings applicable to your business requirements. See the Oracle Fusion Cloud Applications:
Using Functional Setup Manager guide to manage the opt-in and setup of your offerings.

This topic provides these information:

• Prerequisite tasks and pertinent information about implementing Oracle Fusion Cloud Talent Review and
Succession Management

• Information about the Talent Review and Succession Management functional areas of the Workforce
Development offering

Prerequisites
Before setting up Oracle Talent Review and Succession Management, you must implement one of these bases:

• HCM Base

• Talent Management Base

You're also required to configure other applications and elements. The table lists sources of information, including
guides and help topics, and a description of what they contain, to help you set up the configuration that fits your
business needs and processes.

Source Contents

Oracle Fusion Cloud Talent Management:
Getting Started with Your Talent
Implementation
 

Provides an overview of Oracle Fusion Cloud Talent Management options, purchasing and activation
options, basic information for implementing Oracle Fusion Cloud Talent Management applications, and
describes work areas
 

Oracle Fusion Cloud Talent Management:
Implementing Talent Management Base

Describes user and role synchronization, implementation user setup, enterprise and workforce
structures, workforce profiles, approvals, help configuration, and more

1
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Source Contents

  

Oracle Fusion Cloud Human Resources:
Getting Started with Your HR
Implementation
 

Describes user and role synchronization, implementation user setup, enterprise and workforce
structures, workforce profiles, approvals, help configuration, and more
 

Oracle Fusion Cloud HCM: Securing HCM
 

Describes Oracle Fusion Cloud HCM security, types of roles and how to create them, managing user
accounts, types of security profiles and managing them, and Oracle Fusion Cloud Transactional
Business Intelligence and Business Intelligence Publisher security
 

Workforce Development Offering
Use this offering to configure your employee profiles, manage goals, review performance, and manage succession
plans. The following table describes the primary features of this offering that are explained in this guide. For the full list
of functional areas and features in this offering, use the Associated Features report that you review when you plan the
implementation of your offering.

Functional Area Description

Talent Review
 

Use this to conduct talent review meetings, and assess employee performance and progress. You can
associate succession plans and talent pools with a talent review meeting. You can also assign tasks to
members of the review population and create notes about the meeting.
 

Succession Management
 

Use this to create and manage succession plans for key personnel or incumbents in important jobs or
positions. You can also add notes to succession plans.
 

Related Topics
• Plan Your Implementation

Setup Tasks for Implementing Talent Review  
To implement Oracle Fusion Cloud Talent Review, you need to have the privileges of an application implementation
consultant.

Oracle Fusion Cloud Talent Review is part of the Workforce Development offering of Oracle Fusion Cloud Human Capital
Management. Review the tasks listed in this table that are available in the Setup and Maintenance work area before you
set up Oracle Talent Review.

Task Name Description Recommended Help

Manage Administrator Profile Values
 
Talent Review Profile Option Values
 

Configure profile options related to Oracle
Talent Review.

Talent Review Profile Options

2
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Task Name Description Recommended Help

Talent Review Descriptive Flexfields Define a segment for descriptive flexfields for
Oracle Talent Review.

Descriptive Flexfields for Talent Review

Configure Talent Review Dashboard Options Create and update templates that facilitators
can use to configure talent review meetings.

Talent Review Template
 
Ratings Options
 
Box Chart Matrix Options
 
Talent Review Data Options
 
Analytic Options in the Talent Review Meeting
Template
 
Population Filters in the Talent Review Meeting
Template
 
Actions Options in the Talent Review Meeting
Template
 
Color Code Options in the Talent Review
Meeting Template
 
Talent Review Display Options
 

Potential Assessment Configure a potential assessment
questionnaire.

Guidelines for Configuring a Potential
Assessment
 
Configure a Potential Assessment
 

Talent Review Notification Settings Configure notifications for actions done
by reviewers, facilitators and reminder
notifications.

Talent Review Life Cycle
 
Configure Notifications in Talent Review Using
Reports
 

Manage Feedback Visibility Control the visibility settings for notes
associated with talent review meetings.

Considerations for Configuring Anytime
Feedback Visibility Options

Checklist Templates Create a checklist template with Talent Review
Box Assignment event for journeys.

Configure a Talent Review Box Assignment
Event for Journeys

Configure HCM Data Loader Control the HCM Data Loader and HCM
Spreadsheet Data Loader import and load
processes.

HCM Data Loader Configuration Parameters

You can also configure notifications for tasks associated with a Talent Review meeting. Use the Talent Review Tasks
Alert template in Alerts Composer to do this. For more information about this, see the Overview of Alerts for Talent
Review Tasks topic.

You can use Transaction Design Studio (TDS) to configure some Oracle Talent Review pages. This table shows the
actions that you can use to configure Talent Review pages and the page for which the action applies.

Action Page

Prepare Review Content
 

Prepare Review Content
 

3

https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20062530
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20062530
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20063762
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20063762
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20036156


Oracle Fusion Cloud Talent Management
Implementing Talent Review and Succession Management

Chapter 1
Introduction

Action Page

Talent Review Notes
 

Notes
 

For more information about this, see the How You Configure Talent Review Pages Using Transaction Design Studio topic.

Security Reference
The tasks that people can do and the data that they can see on Talent Review pages depend on their roles, duties, and
privileges. For information about these factors, see these two guides:

• Securing HCM

• Security Reference for HCM

Setup Tasks for Implementing Succession Management  
To implement Oracle Fusion Cloud Succession Management, you need to have the privileges of an application
implementation consultant.

Oracle Fusion Cloud Succession Management is part of the Workforce Development offering of Oracle Fusion Cloud
Human Capital Management. Review the tasks listed in this table that are available in the Setup and Maintenance work
area before you set up Oracle Succession Management.

Task Name Description Recommended Help

Succession Management Lookups Manage succession management lookups. Succession Management Lookups

Manage Descriptive Flexfields Define a segment for descriptive flexfields for
Oracle Succession Management.

Descriptive Flexfields for Succession
Management

Manage Administrator Profile Values
 

Configure profile options related to Oracle
Succession Management.

How You Enable Succession Organization
Charts

Checklist Templates Create a checklist template with Succession
Readiness event for journeys.

Configure a Succession Readiness Event for
Journeys

Configure HCM Data Loader Control the HCM Data Loader and HCM
Spreadsheet Data Loader import and load
processes.

HCM Data Loader Configuration Parameters

Use the Succession Plans action in Transaction Design Studio to create rules to configure Oracle Succession
Management pages. For more information about this, see the How You Configure Succession Plan Pages Using
Transaction Design Studio topic.
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Security Reference
The tasks that people can do and the data that they can see on Oracle Succession Management pages depend on their
roles, duties, and privileges. For information about these factors, see these two guides:

• Securing HCM

• Security Reference for HCM

Setup Tasks for Implementing Talent Pools  
To implement Oracle Fusion Cloud Talent Pools, you need to have the privileges of an application implementation
consultant.

Review the tasks listed in this table that are available in the Setup and Maintenance work area before you set up Oracle
Talent Pools.

Task Name Description Recommended Help

Manage Descriptive Flexfields Define a segment for descriptive flexfields for
Oracle Talent Pools.

Descriptive Flexfields for Talent Pools

Configure HCM Data Loader Control the HCM Data Loader and HCM
Spreadsheet Data Loader import and load
processes.

HCM Data Loader Configuration Parameters

Use the Talent Pools action in Transaction Design Studio (TDS) to create rules to configure Talent Pool pages as needed
by your organization. For more information about this, see the How You Configure Talent Pool Pages Using Transaction
Design Studio topic.

Security Reference
The tasks that people can do and the data that they can see on Oracle Talent Pools pages depend on their roles, duties,
and privileges. For information about these factors, see these two guides:

• Securing HCM

• Security Reference for HCM

Structure of Implementing Talent Review and Succession
Management Guide  
This guide explains the setup and implementation tasks of Oracle Fusion Cloud Talent Review and Succession
Management.

5
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This topic describes the contents of each chapter included in the following sections of the guide:

• Introduction

• Talent Review

• Succession Management

• Talent Pools

• Personalization Using Transaction Design Studio

Introduction

Chapter Title Contents

1
 

Introduction
 

An overview of implementing Oracle Talent
Review and Succession Management and
description of the guide structure
 

Activate Oracle AI Apps for Talent Management

Chapter Title Contents

2
 

Activate Oracle AI Apps for Talent Management
 

Explains how to configure and activate AI apps
for Oracle Fusion Talent Management products
 

Talent Review

Chapter Title Contents

3
 

Talent Review Overview
 

An overview of Oracle Talent Review
 

4
 

Talent Review Profile Options and Descriptive
Flexfields
 

Describes the consequences of setting up the
talent review profile option and defining a
segment for a descriptive flexfield for Talent
Review
 

5
 

Talent Review Templates
 

Describes how to create talent review templates
and configure the box chart matrix
 

6
 

Potential Assessment
 

Provides an overview of the potential
assessment and describes how to configure it
 

7
 

Talent Review Tasks and Notes
 

Provides an overview of talent review tasks and
notes and how to use them
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Chapter Title Contents

8 Talent Review Integrations
 

Describes how Oracle Talent Review integrates
with other applications
 

Succession Management

Chapter Title Contents

9
 

Succession Management
 

• Overview of succession management

• Overview of lookups and descriptive
flexfields for Oracle Succession
Management

• Describes how to enable succession
organization charts

• Describes how the user can configure
alerts for succession plans

• Explains how you can use succession plan
related deep links

• Describes how you can add an object note
to a succession plan

• Describes how Oracle Succession
Management integrates with other
applications

Talent Pools

Chapter Title Contents

10
 

Talent Pools
 

• Overview of talent pools

• Overview of talent pool related descriptive
flexfields

• Explains how you can use talent pool
related deep links

• Explains how you can dispose talent pool
related data for terminated employees

Personalization Using Transaction Design Studio

Chapter Title Contents

11
 

Personalization Using Transaction Design
Studio

Explains the actions to use in Transaction
Design Studio to configure Talent Review,
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Chapter Title Contents

  Succession Management, and Talent Pool
pages.
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2  Activate Oracle AI Apps for Talent
Management

Welcome to Oracle AI Apps for Talent Management  
Oracle AI Apps for Talent Management uses artificial intelligence and machine learning algorithms to provide features
to the HR specialists, recruiters, candidates, employees, and managers.

Here's a summary of the AI Apps features, along with activation and ingestion scheduled processes details:

Feature Product AI Apps to Activate Scheduled Processes
for Ingestion

Audience Description

Time to Hire Recruiting Time to Hire None. AI Apps will
use BI Publisher
credentials to retrieve
data

Recruiters Provide estimates
about the time taken
to make a hire for job
requisition.

Suggested Candidates Recruiting AI Talent Best Match Synchronize
Talent Data for AI
Recommendations

Recruiters Suggest best-fit
candidates for job
requisitions.

Similar Candidates Recruiting AI Talent Best Match Synchronize
Talent Data for AI
Recommendations

Recruiters Find candidates
who have skills and
experience similar to
existing candidates.

Similar Jobs Recruiting AI Talent Best Match Synchronize
Talent Data for AI
Recommendations

Candidates Suggest jobs similar
to the selected job
requisition.

Suggested Jobs Recruiting AI Talent Best Match Synchronize
Talent Data for AI
Recommendations

Candidates Suggest jobs that
match a candidate's
profile.

Skills Advisor for
Candidates

Recruiting Dynamic Skills Synchronize Recruiting
Data for Candidate
Recommendations
 
Synchronize
Talent Data for AI
Recommendations

Candidates Suggest skills to
candidates so that
they can quickly select
the relevant skills and
add details.

Skills Advisor for Job
Requisitions

Recruiting Dynamic Skills Synchronize Recruiting
Data for Candidate
Recommendations
 
Synchronize
Talent Data for AI
Recommendations

Recruiters Suggest skills to
recruiters so that
they can quickly add
the required skills
to a requisition and
enhance the job
description.

Suggested Careers Career Development AI Talent Best Match Synchronize
Talent Data for AI
Recommendations

Employees Suggest careers to
employees to plan
their career path.

9
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Feature Product AI Apps to Activate Scheduled Processes
for Ingestion

Audience Description

Suggested Successors Succession
Management

AI Talent Best Match Synchronize
Talent Data for AI
Recommendations

HR specialists
 
Managers
 

Suggest candidates
for HR specialists and
managers to add to
succession plans.

Skills Center Profile Management Both Dynamic Skills
and AI Talent Best
Match

Synchronize Recruiting
Data for Candidate
Recommendations
 
Synchronize
Talent Data for AI
Recommendations

Employees
 
Managers
 

Provides a centralized
place for employees
and managers to
manage skills and
suggest actions to
drive personal and
organizational growth.
 

Skills Advisor for Job
Profiles

Profile Management Both Dynamic Skills
and AI Talent Best
Match

Synchronize Recruiting
Data for Candidate
Recommendations
 
Synchronize
Talent Data for AI
Recommendations

Recruiters Provide AI suggestions
for skills for recruiters
to enter skills for job
profiles.
 

Skills Advisor for
Position Profiles

Profile Management Both Dynamic Skills
and AI Talent Best
Match

Synchronize
Talent Data for AI
Recommendations

HR administrators Suggest relevant skills
for HR administrators
to create and maintain
a targeted position
specification.

Skills Advisor for Gigs Opportunity
Marketplace

Dynamic Skills Synchronize Recruiting
Data for Candidate
Recommendations
 
Synchronize
Talent Data for AI
Recommendations

Gig creators
(Recruiters, managers)
 
Candidates
 

Provide skill
suggestions that
gig creators can
associate with their
gigs. Provide an ability
for candidates to see
the skills comparison
of the gig against their
own skills.
 

Skills Advisor for
Learning

Learning Dynamic Skills Synchronize
Talent Data for AI
Recommendations

Learning
administrators

Suggest appropriate
skills to set as learning
outcomes when
configuring a course
or specialization.

Note:  The AI Apps features work only when the environment uses English as the operation language.

To activate AI Apps for Talent Management, see Activate Oracle AI Apps for Talent Management.

Activate Oracle AI Apps for Talent Management  
As part of configuring the AI Apps features, you will need to activate Oracle AI Apps.

These steps apply to all features except time to hire. To activate the Time to Hire feature, see Set Up Time to Hire.

10
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Before you start
To complete these activation steps, you must:

• Either have the predefined role Application Implementation Consultant (22D and above)

• Or have a custom role that inherits the predefined role Adaptive Intelligence Applications Administrator (22C
and above)

Note:
• When you activate Dynamic Skills, you must also activate AI Talent Best Match.

• If you were recently granted either the Application Implementation Consultant role or the Adaptive Intelligence
Applications Administration role, you might be denied access while activating an app, or the status of the
app may appear as Unavailable. Try signing into the application with another user who had the Application
Implementation Consultant role granted to them a while ago.

Here's what to do

1. Sign into your Oracle Fusion Application.
2. On the home page, click the Tools tab and then click the quick action AI Apps Administration.

The Application Administration page displays a list of apps and their current activation status.
3. Click the row for the app you want to activate, for example, Dynamic Skills.
4. On the app page, click Activate App.

The status changes to Processing, and then will change to Active. It may take about 5 to 20 minutes for the status to
change from Processing to Active.

Ingestion Steps for AI Apps Features  
These steps apply to all Oracle AI Apps features except time to hire, and are meant for the implementation user.

Note:  You must complete these steps to make sure that all the AI features work as expected.

These scheduled processes extract data from your Oracle HCM and transfer the data to the connected AI Apps
environment. This data will then be processed by machine learning pipelines to build custom machine learning models.
See the table in the topic Welcome to Oracle AI Apps for Talent Management to understand the AI application to activate
and the processes for data ingestion.

Here are a few things to keep in mind:

Here's what to do

• These steps are required for all the AI features except time to hire.
• You must not proceed further unless you completed the steps outlined in the previous sections.
• You must set the ORA_HRT_AI_SKILLS_ASSISTANT profile option and/or the ORA_HRD_AI_BEST_ROLES

profile option to Yes to integrate with AI Apps.
a. Sign into your Oracle HCM application and navigate to the Setup and Maintenance work area.

11
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b. Search for and click Manage Administrator Profile Values.
c. Search for and select the profile option ORA_HRT_AI_SKILLS_ASSISTANT or ORA_HRD_AI_BEST_ROLES.
d. In the Profile Values section, make sure that the Profile Level is set to Site.
e. Set the Profile Value field to Yes.
f. Click Save and Close.

• If you're following these steps in a nonproduction environment, set the jobs to run just once. If you're setting
this up in a production environment, you must set up a recurring schedule. Oracle recommends that you run
these scheduled processes once a week initially and then decide if you need to do it more often. For example,
you might need to do it more often if you've a significant hiring cycle, if you revised competencies, and so on.
The first execution of these scheduled processes will take significantly longer because the scheduled process
will try to extract historical data. Subsequent runs will be faster because the process extracts only incremental
changes since the last run.

• After the scheduled processes complete, anonymized data from HCM Cloud will have been exported to the
AI cloud service. Processing of this data will begin automatically and is expected to take about 8-12 hours
to complete, depending on the volume of data. You can expect to start seeing recommendations after this
process completes.

• If AI Talent Best Match is already activated and you’re now activating Dynamic Skills, these scheduled
processes might already be running in your environment. You might not need to run the processes again.

Synchronize Talent Data for AI Recommendations  
If you’re live on Career Development, Succession Management, or Dynamic Skills, then you need to schedule the
Synchronize Talent Data for AI Recommendations process to view AI-based suggestions.

1. Sign in as an admin user with the PER_RUN_HR_PROCESSES_PRIV privilege.
2. Select Scheduled Processes from either the Tools tab or from the navigator.
3. Click Schedule New Process.
4. Search for the job Synchronize Talent Data for AI Recommendations.
5. Provide the parameters according to this table.

Parameter Value

AI Feature ◦ If you’re activating AI Talent Best Match, select Best Profile Matches.

◦ If you’re activating Dynamic Skills, select Skills Suggestions.

◦ If you’ve activated both these applications, run two different scheduled processes, one with the
value Best Profile Matches, and another for Skills Suggestions.

Talent Object Select All to ingest all object types. You may optionally choose to ingest one talent object at a time.

From Date Indicates the date from which we want the Talent Object data to be pushed to AI cloud.
 
When left blank, an incremental ingestion will pick the Talent Object data from the last successful
run.
 

Number of Threads Select the number of parallel java processes to run during ingestion. Use the default value unless
you've a specific reason to select a different value.
 
Default: 8, Minimum: 1, Maximum: 20

12
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Parameter Value

 

Submission Notes Provide optional comments regarding the current scheduled process.

6. Click Submit.
7. Use the refresh icon to track recently submitted jobs.

What to do next

There will be a parent job and one or more child jobs depending on the parallel threads in action.

After the jobs complete successfully, you can check the scheduled process logs to get more details like the ingested file
names, ingestion path, the number of profiles, and so on. These logs also record any errors that may occur.

13
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3  Talent Review Overview

Talent Review  
The talent review process involves one or more talent review meetings. Its purpose is to evaluate workers who are part
of the review population, assess their strengths, and address areas of risk for the organization.

Use the Talent Review work area to create, edit, and conduct talent review meetings. Select My Client Groups >  Talent
Review to access this work area.

Talent Review Stakeholders
This image shows the stakeholders of a talent review meeting.

This table lists what facilitators and participants do in a talent review meeting.

Stakeholder Who They Are What They Can Do Comments

Facilitators
 

• Human resource (HR)
specialist (or other HR
business partner)

• Organizational business
leader

• Manage and conduct the
meeting.

• Add development and
performance goals for the
review population.

• Goals created in a Talent
Review meeting are
automatically assigned to the
worker as an individual goal.
The worker or manager can
view the goal in the worker's
goal page.
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Stakeholder Who They Are What They Can Do Comments

• Create tasks for the review
population.

• Create notes about the
meeting.

• Add workers in the talent
review meeting dashboard to
talent pools and succession
plans.

• Create talent pools and
succession plans for the
meeting.

• You track tasks to completion
using the Tasks page.

Participants
 

Line managers
 

• Review worker profile,
 performance, goals, and
compensation data before the
meeting starts.

• Calibrate ratings of the review
population.

• View worker data, such as
competencies and degrees in
the worker's person spotlight.

You can review worker ratings for
any level of the organization. For
example, you can review workers in
an organization as a single group.
Or, you can filter workers by job,
 location, or other categories.
 

Worker Ratings
As a meeting participant, you can review the ratings of workers to understand worker strengths and weaknesses. You
can view any of these ratings on the box chart matrix:

• Performance

• Potential

• Overall competencies

• Overall goals

• Impact of loss

• Risk of loss

• Talent score

You can configure the box chart views and combine the ratings to review data critical to your business process. You can
switch from one view to another and can rate the workers using different criteria on the alternate view.

Any rating updates from the meeting appear in the worker profile data. You can identify them as talent review ratings to
distinguish them from other ratings, such those from a performance evaluation.

Talent Review Deep Links
You can use deep links to navigate directly to the Talent Review pages indicated in this table.

Deep Link Navigates To

Overview (HR_TALENT_REVIEW_
OVERVIEW)

Facilitator Talent Review Meetings page
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Deep Link Navigates To

 

Overview (MGR_TALENT_REVIEW_
OVERVIEW)
 

Manager Talent Review Meetings page
 

Related Topics
• Succession Planning

• How Succession Plans, Talent Pools, and Talent Reviews Work Together

• Talent Pools

• Talent Review Life Cycle

Talent Review Life Cycle  
The talent review process includes tasks from creating the meeting template through conducting the review meeting to
managing notes and tasks created for the meeting.

Manage talent reviews in the Talent Review work area. Select My Client Groups > Talent Review.

This image shows the different stages of the talent review process and identifies responsibilities.
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Let's now see what each stage involves.

Create Talent Review Template
The human resource (HR) specialist creates a talent review template in the Setup and Maintenance work area.
Facilitators can use the same template for many talent reviews. In the template, the HR specialist can specify these
attributes of a meeting:

• The size of the review population

• The box-chart matrix options and default presentation

• The data available to meeting participants

• The actions that participants can perform

The HR specialist can also indicate if the review can include succession plans and talent pools.
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Create a Meeting
Meeting facilitators, who have the HR specialist role can create talent review meetings. A meeting can have multiple
facilitators, any of whom can perform these tasks when creating a meeting:

1. Select a talent review template.
2. Schedule the meeting.
3. Select the content available for reviewers to prepare before the meeting, from the options specified in the talent

review template.
4. Select meeting participants and designate them as either reviewers or participants who act as observers.
5. Identify the review population.

When a facilitator submits the meeting configuration, if New meeting scheduled notification is enabled, the
participants receive notifications to prepare review content for the meeting.

Prepare Review Content
Participants who are designated as reviewers submit content for their direct and indirect reports before the meeting is
conducted. The content can include ratings for these profile data:

• Performance

• Potential

• Overall competencies

• Overall goals

• Impact of loss

• Risk of loss

• Talent score

Reviewers can grant access to other managers below them in their hierarchy to submit data for their own direct reports.
When reviewers submit the data, any changes to the ratings appear in the profiles of reviewed workers.

These talent review notifications can be enabled for tracking content submission:

• Talent review content preparation reminder notification: Facilitators can send reminder notifications to
reviewers when the submission deadline approaches.

• Submit talent review meeting content notification: Facilitators receive a notification when reviewers submit
their ratings.

Conduct the Talent Review Meeting
The facilitator starts the meeting in the Talent Review work area. During the meeting, participants provide information
about the worker ratings. The facilitator then calibrates the ratings on the dashboard.

Workers in the review population who weren't assessed before the facilitator started the meeting appear in the meeting
Holding Area, if it's available.

The facilitator, after consulting with the participants can perform any of these actions during the meeting:

• View and update the meeting box chart.

• Review profile and compensation details of individual workers in the review population on the worker's person
spotlight.
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• Compare current data to that from previous meetings.

• Compare a worker to another worker or to a job profile.

• Open the organization chart of the organization that's being reviewed.

• Add workers in the review population to talent pools or succession plans, if the pools and plans are included in
the meeting template.

• Move workers in the review population from the box chart to the Holding Area or from the Holding Area to the
box chart.

• Assign performance and development goals to workers.

• Assign tasks to anyone in the organization.

• Create notes for workers in the review population.

• Save the meeting or submit it to freeze the data.

Note:  Facilitators can perform actions depending on the meeting template configuration.

These are the consequences of a facilitator saving the meeting data:

• Goals, notes, and tasks are saved immediately.

• Workers can access performance goals assigned to them from their goal management pages, and manage
development goals from their career development pages.

When the facilitator submits the meeting data, any profile changes appear in the worker's profile record.

Manage Notes and Tasks
Facilitators can manage and monitor notes and tasks added in meetings, and review them for all workers for all
meetings.

Related Topics
• Talent Review Template

• Guidelines for Selecting Participants for Talent Reviews

• How You Prepare Content for a Talent Review Meeting

Deep Links  
You can use deep links to provide easy navigation directly to a page in the HCM Cloud application.

You can also use deep links for mobile responsive pages on your intranet, custom and third-party applications, or in a
document. This helps people run transactions in the HCM cloud and provides quick access to their HR information.

To access deep links:

1. Open the main menu.
2. Go to Tools >  Deep Links.
3. Copy the URL for a deep link.
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4. Paste the URL in the appropriate location.
When you open Deep Links, you find a list of all available deep links.

FAQs  

How can I diagnose any issues with Talent Review data?  
Run the Talent Review Integrity Validations test if you've access to the Diagnostic Dashboard. From the Settings and
Actions menu, select Run Diagnostic Tests. The test generates a report identifying invalid rows, which you can repair or
remove.

You can validate these from the test results:

• Business groups are valid and exist.

• Foreign key attributes aren't null.

• Row counts on setup tables are greater than zero.
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4  Talent Review Profile Options and
Descriptive Flexfields

Search Logic Profile Options for Client List of Values  
You can use the logic <codeph>CONTAINS</codeph> to create the client list of values. This returns results containing
the characters you enter.

Optionally, for individual list of values, you could change this logic to <codeph>STARTS WITH</codeph>, to return
results that start with the search characters you enter.

For example, when you search for a person with the name John Smith while using the logic CONTAINS, you can search by
'jo' or 'sm' or 'th'. When you use the logic STARTS WITH, your search must start with 'j'.

Use the logic STARTS WITH when your list contains thousands of values (more than 15,000 records) to improve the search
performance. Or, if you don't partition your data by set ID.

Note:  If you change the search logic for a client list of values, the logic changes in all pages where the list of values is
used.

Related Topics
• Search Logic Profile Options for Client List of Values in Global Human Resources

Talent Review Profile Options  
As an application implementor, you can use Talent Review profile values to configure the Oracle Fusion Cloud Talent
Review work area.

You can use profile options for these configurations:

• Specify the folder to store analyses for selecting the review population for a meeting.

• Indicate if meeting facilitators can include themselves in the review population or not.

• Enable responsive Oracle Talent Review pages.

• Configure how manager search works in responsive pages.

General Profile Option
This table describes the Oracle Talent Review profile value for specifying the default reports folder and lists the task that
you need to use to change the profile value.
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Profile Option Code Profile Display Name Default Value What Happens When
You Change the
Profile Value

Task to Use Comments

HRR_DEFAULT_
REPORT_FOLDER
 

Default Reports Folder
for Talent Review
 

None
 

HR specialists can
add analyses to the
specified folder.
They can then select
an analysis to add
workers to the review
population of a talent
review meeting.
 

Talent Review Profile
Option Values
 

• You can copy
the folder
path directly
from Oracle
Transactional
Business
Intelligence
(OTBI) by
navigating
to Properties
for one of the
analyses in the
folder. You can
then paste the
copied location in
the Profile Value
field.

• You can enter
only one folder
location.

• The profile value
must start with a
forward slash (/),
 but not end with
a forward slash.

ORA_HRR_ALLOW_
FACILITATOR_TO_
SEARCH_OWN
 

Allow facilitator to
add themselves to the
review population
 

Y
 

Meeting facilitators
can’t include
themselves in the
review population
of a Talent Review
meeting.
 

Manage Administrator
Profile Values
 

If a Talent Review
meeting has more
than one facilitator,
 a facilitator can add
any of the other
facilitators to the
review population.
Also, facilitators
can always include
themselves as review
participants.
 

Responsive Profile Options
Some profile options are specific to responsive Oracle Talent Review. Use the Manage Administrator Profile Values task
to change the responsive profile options.

Tip:  Select the Talent Review application and click Search.

This table describes the Talent Review profile values that are used for responsive Oracle Talent Review pages and lists
the default value of the profile options.

Profile Option Code Profile Display Name Default Value Effect of Enabling

ORA_HRR_TALENT_REVIEW_
RESPONSIVE_ENABLED

Mobile-Responsive Talent Review
Pages Enabled

Y
 

You will see the responsive Talent
Review pages.
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Profile Option Code Profile Display Name Default Value Effect of Enabling

   

ORA_HRR_LOV_SEARCH_
TRMANAGERS_STARTSWITH
 

Search for Talent Review Managers
Starts with Enabled
 

Y
 

When you search for managers
to include in a meeting on a
responsive Talent Review page,
 the search results include manager
names that start with the specified
characters.
 

Related Topics
• How You Select the Review Population for a Talent Review Meeting

• Overview of Profile Options

Descriptive Flexfields for Talent Review  
You can add descriptive flexfields to a Talent Review meeting template or meeting configuration pages.

You can use descriptive flexfields to add your company-specific attributes to an entity.

Define Descriptive Flexfield Segments for Talent Review
Use the Talent Review Descriptive Flexfields task to define a segment for a descriptive flexfield for Talent Review.

This table describes two descriptive flexfields available by default in Talent Review.

Flexfield Code Name Description

HRR_DASHBOARD_TMPLS_B
 

Dashboard Template
 

Fields for template details that appear on the
Create Talent Review Template and Talent
Review Template pages.
 

HRR_MEETINGS
 

Dashboard Meetings
 

Fields for meeting configuration details that
appear in the Meeting Info section.
 

Related Topics
• Overview of Descriptive Flexfields

• Overview of Flexfields

• Considerations for Planning Descriptive Flexfields

• Considerations for Managing Descriptive Flexfields

25

https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20053950
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20052785
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20030935
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20030415
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20043508
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20030923


Oracle Fusion Cloud Talent Management
Implementing Talent Review and Succession Management

Chapter 4
Talent Review Profile Options and Descriptive Flexfields

26



Oracle Fusion Cloud Talent Management
Implementing Talent Review and Succession Management

Chapter 5
Talent Review Templates

5  Talent Review Templates

Talent Review Template  
As an implementor, you create templates which facilitators can use to create talent review meetings. Facilitators can use
the same template for many meetings.

The talent review template controls these aspects of a talent review meeting:

• Inclusion of succession plans and talent pools

• Inclusion of matrix managers as reviewers

• Maximum number of records for a meeting

• Layout of the box chart that displays employee ratings

• Filters that facilitators can use in a meeting

• Actions that facilitators can perform

You create talent review templates on the Talent Review Templates page. You can navigate to this page in these ways:

• Use the Configure Talent Review Dashboard Options task in the Setup and Maintenance work area.

• Use the Search Talent Review Template quick action available in My Client Groups.

This image shows what you typically specify while creating a Talent Review meeting template.
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The maximum number of records you specify in the template is the maximum number of employees allowed for the
review population. The default value is 500.

Related Topics
• Submission Process Threshold

• Ratings Options

• Box Chart Matrix Options

• Talent Review Data Options

• Talent Review Display Options

Submission Process Threshold  
The submission process threshold that you specify in a Talent Review meeting template controls the scheduling of a
process used to update ratings in employee profiles.
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We recommend setting the submission process threshold's value to not more than 100. This will ensure that the ratings
are correctly updated in the employee's talent profile for talent review meetings with a larger review population. This
table indicates the effect of the submission process threshold for actions performed by a facilitator or reviewer.

Action Effect of Submission Process Threshold

Facilitator submits the meeting A process to update the talent profile ratings of the members of the review population is triggered
when the size of the review population equals or exceeds the submission process threshold. For
example, if you enter 70 as the submission process threshold, when there are 70 or more employees in
the review population, a scheduled process is automatically run to update the profile ratings when the
facilitator submits the meeting.

Manager submits the ratings after
preparing review content

A process to update the talent profile ratings of the members of the review population is triggered
when the number of employees rated by the manager equals or exceeds the submission process
threshold. For example, if you enter 70 as the submission process threshold, when there are 70
or more employees rated by the manager while preparing review content, a scheduled process is
automatically run to update the profile ratings when the manager submits the ratings.

When the scheduled process starts, a message displays the job number. You can also see the job number of the process
next to the meeting status in the Talent Review Meetings overview page. You can track the process using this job
number.

Ratings Options  
In the Ratings Options section of the Talent Review template, specify the ratings that reviewers can use to rate the
review population.

You can include both delivered ratings and custom ratings in a Talent Review template. When adding ratings, we
strongly recommend that you select a rating model that's also used for the rating type in other Talent Management
offerings. These are the advantages of selecting a consistent rating model:

• The ratings given to workers in the other Talent Management offerings are available in Talent Review. Ratings
assigned in Talent Review are available in the other offerings.

• Facilitators and participants can view the latest worker's Profile data in the meeting.

• Facilitators and participants can compare the meeting ratings with those from previous meetings and identify
the worker's progress.

Delivered Ratings
This table describes the delivered ratings that are available for including in a Talent Review template.

Ratings Description

Impact of loss
 

Evaluate the real or perceived effects on an organization when a person leaves.
 

Overall Competencies
 

Evaluate the overall competency of a person. A competency is a combination of measurable
knowledge, skills, and personal attributes that contribute to a person's performance.
 
If you've configured many content sections for Overall Competencies Rating in Profile Management,
 you can select the content section to include in Talent Review. In the Content Section column, select
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Ratings Description

the content section to use when you’re creating a new template or editing a template that’s not in
use. If you don't specify the content section to use, then only the latest rating provided for any of
the sections of the Overall Competencies Rating content is considered. If your organization has
configured only one content section for Overall Competencies Rating in Profile Management, then
you don't need to select a content section.
 

Note:
If the performance document is configured to allow section ratings and to update Profiles with the
performance document rating, then the overall competencies rating is pulled from Profiles. Else,
 facilitators need to update this rating while conducting the talent review meeting.
 

Overall Goals
 

Evaluate the overall goal achievement of a person.
 

Note:
If the performance document is configured to allow section ratings, then the overall goals rating is
pulled from Profiles. Else, facilitators need to update this rating while conducting the talent review
meeting.
 

Performance
 

Evaluate a person based on their work.
 

Potential
 

Evaluate a person's attainable level of excellence or ability to achieve success.
 

Risk of loss
 

Evaluate the likelihood of a person leaving the company.
 

Talent score
 

Evaluate a person's overall value to the organization using a rating model your organization defines.
You can score workers based on factors beyond performance and potential. These might include
readiness, ability to mentor, and learning agility.
 

Custom Ratings
If you're using Enhanced Talent Profiles, you can also include custom ratings that you create in Talent Profiles. For
example, you can create a rating to assess the innovative thinking of your employees in Talent Profiles and select the
rating in the template.

When you create a new rating section for custom talent ratings, remember to select the Employee View and Manager
View check boxes for these evaluator types:

• Profile

• Talent Review

• Talent Review Meeting Preparation

Related Topics
• Talent Review Template

• Person Profile
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Box Chart Matrix Options  
In a Talent Review meeting template, as administrators you can configure the box chart matrix of the meeting
dashboard. The settings apply for all Talent Review meetings created using the template.

You create talent review templates on the Manage Talent Review Templates page.

Box Chart Views
In the Box Chart Views section of the template, you add and configure the available views, using the ratings you
selected in the Ratings Options section.

The rating models that you selected for the ratings in a view decides the dimensions and number of boxes in the box
chart. For example, if you map a performance rating model with two rating categories to the X-axis, and a potential
rating model with three categories to the Y-axis, then the box chart contains six boxes (2 x 3).

Note:  The rating models you select for the X and Y axes of an XY view must contain rating categories. If the rating
models you select don't have rating categories, the box chart doesn't appear because the dimensions can't be
identified.

Related Topics
• Talent Review Template

• Ratings Options

• Configure Box Chart Views

• Enable Background Colors for Boxes in a Box Chart View

Configure Box Chart Views  
As administrators when creating or editing a Talent Review template, you can configure multiple unique box chart views
to display worker ratings.

In the meeting, facilitators can update worker ratings for the rating types you specify as views in the box chart.
For example, you can create one view that allows meeting participants to rate employees both on risk of loss
and performance. You can also create a single rating view that allows the meeting participants to rate the overall
competency of the employees in the review population.

1. Add a box chart view.
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2. Specify these values for the box chart view:

◦ View name: Enter a unique name that will let the facilitator know the use of the box chart view.

◦ View Type: Select from the two available types:

- XY View: Uses two separate ratings as the axes
- Single Rating View: Uses one rating as the lone measure

◦ X-Axis or Single Rating: Select the rating that you want to use on the X-Axis of the box chart or for the
single rating view.

◦ Y-Axis: Select the rating that you want to use on the Y-Axis of the box chart.

3. Set the default view. Facilitators can switch between views during the meeting.
4. Configure the boxes that appear in the box chart:

◦ For box charts of the XY View type, the number of rating categories in the rating models you selected
decides the box-chart dimensions. For example, one rating model combination might deliver a nine-box
configuration and another a six-box configuration.

◦ For box charts of the Single Rating View type, you select the dimensions and the rating levels to populate
each box. You can select from one to five rows and columns, up to a maximum of 25 (5 x 5) boxes in the box
chart.

5. Add labels for the boxes that appear in the box chart.

Note:  For ratings used in the XY view, you can enter any label.

6. You can submit the box assignment for only one XY and one Single Rating view. When you select Submit Box
Assignment for a view, the labels of the boxes appear in the table view of the box chart.

Enable Background Colors for Boxes in a Box Chart View  
When creating a Talent Review template, you can enable background colors for each box of a box chart view. This
enables facilitators and participants to distinguish levels or ratings.

You need to configure colors for each box chart view. The colors configured for one view aren't applied to other views. If
you don't select a color for any box, then the background color of the box is gray by default.

1. In the Box Chart Views section, click the Edit icon in the Configure Boxes column for the view that you want to enable
background colors for.

2. In the Configure Boxes dialog box, select the color for the boxes that you want to have a colored background.

Tip:  Click Show hexadecimal code to view the hexadecimal code for the colors.

3. Click OK.

Results:
The colors configured are applied to the boxes in the box chart of the meeting dashboard when facilitators conduct a
meeting or reviewers preview the dashboard while preparing review content. The Prior Ratings legend also shows the
colors configured.
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Talent Review Data Options  
When creating templates for talent review meetings, you specify the data and actions available to meeting facilitators
and participants.

To create templates for talent review meetings, use the Configure Talent Review Dashboard Options task in the Setup
and Maintenance work area.

We can classify the data options available on the meeting template page into these categories:

• Analytic options

• Population filters

• Actions

• Color code options

Note:  To restrict access to reviewers, meeting facilitators can override the configured data options available on the
Prepare Review Content page when creating a meeting.

Related Topics
• Talent Review Template

• How Succession Plans, Talent Pools, and Talent Reviews Work Together

Analytic Options in the Talent Review Meeting Template  
When creating or editing a Talent Review meeting template, you can select the analytic options that you want to appear
on the box chart matrix.

This table lists the analytic options of the talent review meeting template and shows when these options are available.
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Analytic Option Condition for Availability

Risk of loss
 

Risk of loss rating model must exist
 

Impact of loss
 

Impact of loss rating model must exist
 

Mobility
 

Mobility content type must exist
 

The profile management business process has predefined values for each of these analytic options. The selected
analytic options appear on the box chart matrix. Facilitators and reviewers can select up to two of these values at one
time during the meeting.

Population Filters in the Talent Review Meeting Template  
When creating or editing a Talent Review meeting template, you can select the population filters to be displayed on the
talent review meeting dashboard.

The population filters include business unit, job, and competency. Facilitators can filter the review population using
these filters.

These population filters let you specify whom to include in the review population:

• Manager: Shows all managers in the review population hierarchy, even if they've no direct reports in the review
population.

• Reviewers and Participants: Shows all the direct and indirect reports of the reviewers and participants if
they're part of the review population.

• Subordinate Level: Shows only the subordinates of the meeting business leader.

• Management Level: Shows only people at the specified management level.

• Department: Shows only members of the review population from the selected departments.

Actions Options in the Talent Review Meeting Template  
When creating or editing a Talent Review meeting template, you can specify the actions facilitators can perform while
conducting the review meeting.

You can select the actions options shown in this table for the Actions section of the talent review dashboard.

Action Options What It Does Comments

Add Notes
 

Facilitators can add notes about the meeting
or for any person in the review population.
Facilitators can also manage notes created
by the worker's manager during the content
preparation phase before the talent review.
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Action Options What It Does Comments

Add Task
 

Facilitators can assign tasks to meeting
participants and others.
 

The tasks added appear in the Manage Notes
and Tasks task the facilitator uses after the
meeting to follow up on assigned tasks.
 

Add Goal
 

Facilitators can create goals or assign
performance or development goals from the
goal library.
 

The goal management business process must
be available to create performance goals. The
career development business process must be
available to create development goals.
 

Enable Holding Area
 

The Holding Area displays workers without
ratings at the start of the meeting.
 

During the meeting, participants can move
workers to this area from the box chart. If you
don't enable the Holding Area, workers without
ratings at the start of the meeting don't appear
in the review.
 

Enable Compare
 

Participants can compare a worker with other
workers or a job profile.
 

You can see the Enable Compare check box
in the Actions section of the Talent Review
Template page only if the Hide Person
Compare Flow profile option's value is N.
 

Enable Organization Chart
 

Participants can view the organization chart of
the organization being reviewed.
 

 

Enable Potential Assessment
 

Before the meeting, reviewers answer potential
assessment questions on the Prepare Review
Content page. The potential rating is calculated
automatically based on the responses.
 

 

Color Code Options in the Talent Review Meeting Template  
Use the color code options to let facilitators and participants to highlight selected segments of the review population.

You can highlight the review population by these criteria:

• Gender

• Age

• Ethnicity

• Religion

• Job

• Location

• Manager

Facilitators can view the average ratings for all workers within that option. For example, if a facilitator selects the
Location color code option while conducting the meeting, all workers in the review population are categorized by
location. Workers belonging to the same location are highlighted with the same color.
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Talent Review Display Options  
When creating or editing a talent review meeting template, you can specify the display options that meeting facilitators
and participants can see on the meeting dashboard for these ratings:

• Risk of loss

• Impact of loss

• Mobility

To create or edit a talent review meeting template, use the Configure Talent Review Dashboard Options task in the
Setup and Maintenance work area.

Configure Display Options
Here's how you configure the display options in the talent review meeting template:

1. From the Preferred Display Option list, select whether you want to show colors or shapes.
2. Specify the colors or shapes to use for each analytic value.

Note:  You can't select a color or shape for the No value and Secured analytic values. You can see default
colors or shapes for these analytic values.

3. Save your changes.

You can enter only the preferred display option for an analytic and not select any shapes or colors for each value. But
if you do so, the facilitators and participants might see some random shapes or colors on the dashboard. Let's assume
that you selected Colors as the preferred display option for the Risk of Loss rating but didn't specify the colors to show
for each value. The facilitator might once see a high risk of loss in red, medium in yellow, and low in green. The next
time the colors shown for the values might not be the same.

Advantages of Configuring Display Options
After you specify the display options, facilitators can view consistent shapes or colors for each analytic rating value.
For example if you selected Colors as the preferred display option for the Risk of Loss rating and then selected the red
color for the High value, then in all meetings that are created based on the template, the facilitator will always see high
Risk of Loss ratings indicated by the red color.

How You Include Matrix Managers as Reviewers  
Your organization can ensure a comprehensive review of its employees by allowing matrix managers to rate the
performance of their dotted line reports. Matrix managers are other managers who aren't defined as the employee's line
manager.

Matrix management can be enabled on these two Talent Review pages:

• Meeting templates

• Meeting configuration pages
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Meeting Template
If your organization usually includes matrix managers in your Talent Review meetings, as administrators you can enable
inclusion of matrix managers in the Talent Review template.

1. In the Setup and Maintenance work area, search for and select the Configure Talent Review Dashboard
Options task.

2. Create or edit an existing template.
3. Select the Include matrix managers as reviewers check box.
4. Save your changes.

Meeting Configuration Pages
Even if your administrators haven't enabled adding matrix managers as reviewers, as facilitators you can enable this
when you create a Talent Review meeting.

1. Create a talent review meeting.
2. In the Review Participants section, select the Include matrix managers as reviewers check box.
3. Submit your meeting configuration after you've configured the meeting.

Note that the setting in the Talent Review meeting configuration decides the inclusion or exclusion of matrix managers.
If you clear the Include matrix managers as reviewers check box in the meeting configuration, matrix managers can't
review their dotted line reports even if matrix management is enabled in the template.

Related Topics
• What happens when you opt to include matrix managers as reviewers in a Talent Review template?

FAQs  

What happens when you include succession plans and talent
pools in a Talent Review template?  
When creating or editing a Talent Review template, you can opt to include succession plans and talent pools.

When you do so, facilitators and reviewers can perform these actions:

• When creating a meeting based on the template, facilitators can add succession plans and talent pools that
they can access to the meeting.

• When preparing review content, reviewers can add employees to plans and pools that they can access in the
participant view of the dashboard. They can also add succession plans and talent pools.

While conducting a meeting, facilitators can perform these actions:

• Add employees in the review population as candidates to plans included or created in a meeting.

• Add employees in the review population as members of talent pools included or created in a meeting.

Related Topics
• How Succession Plans, Talent Pools, and Talent Reviews Work Together

37



Oracle Fusion Cloud Talent Management
Implementing Talent Review and Succession Management

Chapter 5
Talent Review Templates

What happens when you opt to include matrix managers as
reviewers in a Talent Review template?  
If you enable the inclusion of matrix managers as reviewers in the template, and if facilitators don't change this setting
in the meeting configuration when they create a new meeting, facilitators can add matrix managers as reviewers for the
meeting.

Can I edit a talent review template after it has been used for a
meeting?  
Yes. On the Manage Talent Review Templates page, you can edit attributes including axis labels, default view, box labels,
color scheme, status, and data options.

You can't edit the template name, owner, selected rating models, number of boxes in the box chart views, and the
maximum number of records.

Changes take effect when you next open the meeting.

Why should I create multiple Talent Review templates?  
As an administrator you can create multiple Talent Review meeting templates for your organization.

You might need to create multiple templates for these cases:

• Each organization or geographic region uses different rating models to rate employees.

• Organizations use different box-chart configurations. For example, one organization uses a nine-box
configuration and another uses a six-box configuration.

• Industry or legislative rules governing diversity data, such as age and gender, vary by organization or
geographic region.

What happens when I inactivate a talent review meeting template
that's in use?  
When you inactivate a talent review meeting template that's in use, the meetings that are configured using the template
might be affected based on their status.

See this table to know more about the impact of inactivating a talent review meeting template that's in use.
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Meeting Status Impact

In-Progress No impact. Facilitators can conduct and submit the talent review meeting.

Not Started • If the meeting date is in the past or on the current date, then there's no impact. Facilitators can
conduct and submit the talent review meeting.

• If the meeting date is in the future, facilitators when editing the meeting need to select another
active meeting template.

Canceled Facilitators when editing the meeting need to select another active meeting template.

Facilitators when trying to duplicate a meeting that was configured based on a template that's now inactive need to
select another active meeting template.

What happens if I don't select a preferred display option for the
ratings or specify the color or shape to use for a rating level?  
The facilitators and participants will see random colors or shapes on the meeting dashboard for the analytic values.

For example, a facilitator might see a high Risk of Loss in red once and might see the same rating value in green the
next time they view the meeting dashboard.

Can I specify the same preferred display option for more than one
analytic?  
Yes. But note that on the Talent Review meeting dashboard, only the preference for the first selected analytic option is
honored.

Let's assume that you selected Colors as the preferred display option for both Risk of Loss and Impact of Loss analytic
measure in the template. When conducting the meeting, the facilitator first selects the Risk of Loss display option
on the dashboard. The facilitator can see only the color preferences that you selected for the Risk of Loss analytic
measure. The colors specified for the Impact of Loss analytic measure are ignored.
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6  Potential Assessment

How You Set Up Potential Assessment  
The potential assessment is a questionnaire that reviewers of a talent review meeting can use to rate the potential of
workers.

As administrators, you need to create and configure potential assessments before reviewers can use them to prepare
review content. You can create multiple potential assessments for talent review meetings apart from the predefined
potential assessment questionnaire named Potential Rating. Note that you can associate only one potential assessment
with a talent review meeting template or meeting. You can associate a different assessment with each template or
meeting.

This image shows how to set up a potential assessment to rate the review population of a talent review meeting.

Configure Rating Models
You need to configure the Potential and Potential Assessment rating models to add or change rating levels or review
points. As an administrator, you manage rating models on the Profile Rating Models page. In the Profiles work area, use
the Profile Rating Models task to configure rating models.

Create Potential Assessment
An administrator needs to create a potential assessment before it's available to use in meetings.

1. Use the Potential Assessment task available in the Setup and Maintenance work area.
2. To create a new questionnaire, click Create.
3. When you select the template, search for, and select Potential Rating Questionnaire Template.
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4. Ensure to set the status as Active. Facilitators can associate only active questionnaires with Talent Review
templates and meetings.

5. Edit the basic information:

◦ Name of the questionnaire

◦ Status

◦ In the Instructions and Help Materials section, enter any instructions for questionnaire users. This text
appears on the first page of the questionnaire.

6. Add one or more sections.
7. Add or create questions in each section and select response type. To allow reviewers to add comments, select

the Allow Additional Comments check box. You need to add enough questions to ensure that the Potential
Assessment rating model's review points map to the review points range in the Potential rating model.

8. Review and save the questionnaire.

Enable Potential Assessment
When you create or edit a Talent Review template that has potential ratings enabled, you can select the questionnaire to
associate with the template. Note that you can see only active questionnaires. The selected questionnaire is the default
potential assessment questionnaire for meetings created based on the template.

1. Use the Configure Talent Review Dashboard Options task available in the Setup and Maintenance work area.
2. Create a new template or edit an existing template.
3. Select the Enable Potential Assessment check box in the Data Options section of the template.
4. From the Potential Assessment Questionnaire list, select the questionnaire.

Related Topics
• Questionnaires

• Rating Models

• How do I update existing setup data?

Guidelines for Configuring a Potential Assessment  
To allow your reviewers to use the potential assessment feature to rate workers, you need to first configure a potential
assessment questionnaire.

Use the Potential Assessment task in the Setup and Maintenance work area to do this. The Potential Assessment
questionnaires are available in the Potential Rating folder.

Sections
You need to have at least one section for a Potential Assessment questionnaire. You use different sections to group
questions by question type or other criteria. For each section, you can enter specific instructions.

You can select these options for a section:

• Required: To ensure that respondents answer all questions in the section.

• New Page: To start the section on a new page.

42

https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20033891
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20028971
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20051179


Oracle Fusion Cloud Talent Management
Implementing Talent Review and Succession Management

Chapter 6
Potential Assessment

You can also control the order of questions and responses in the section.

Questions and Responses
In each section, you can add questions in these ways:

• Create questions.

• Add questions from the Potential Assessment question library.

Note:  You can't add questions from the question library used for other questionnaires.

For each question that you create, you need to specify these values:

• Question text

• Response type: Single choice from a list or a radio button

To allow reviewers to add comments, select the Allow Additional Comments check box.

Available Responses
The rating levels in the Potential Assessment rating model decide the responses in these ways:

• The number of rating levels is the same as the number of potential responses.

• The text of the response is the short description value for the rating level.

• The value of each response is the numeric rating of the rating level.

Number of Questions
These parameters decide the number of questions you add:

• Number of rating levels and numeric rating for each in the Potential Assessment rating model

• Rating level and corresponding range of review points for each rating level in the Potential Rating Model

To get a valid potential rating, add enough questions so the total of the numeric value of the responses maps to an
appropriate level in the review points. The maximum total value for each rating level should fall between the review
point range for the level.

Related Topics
• How You Set Up Potential Assessment

• Example of Rating Potential Using the Potential Assessment

• How You Determine the Number of Questions to Add to a Potential Assessment Questionnaire

• Configure a Potential Assessment
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How You Determine the Number of Questions to Add to
a Potential Assessment Questionnaire  
To get a valid potential rating, you need to add enough questions so that the total of the numeric value of the responses
maps to an appropriate level in the review points.

Let's now using some examples discuss how to decide the number of questions to add to a potential assessment
questionnaire.

Consider the rating model configuration shown in this table.

Potential Assessment
Rating Model Rating
Level

Potential Assessment
Rating Model
Numeric Rating

Potential Rating
Model Rating Level

Potential Rating
Model Review Points

Potential Rating
Model Review Points
Range For Each Level

Final Potential Rating

1
 

1
 

1
 

1
 

0-13
 

1-Low
 

2
 

2
 

2
 

2
 

14-21
 

2-Medium
 

3
 

3
 

3
 

3
 

22-99
 

3-High
 

The number of questions must ensure that the review points from the Potential Assessment rating model map to the
review points range in the Potential rating model.

Let's assume that there are 7 questions. Here's the total points for each rating level in the Potential Assessment rating
model.

• Rating Level 1: 7 * 1 = 7 points

• Rating Level 2: 7 * 2 = 14 points

• Rating Level 3: 7 * 3 = 21 points

You can see that for Rating Level 3, the total points is less than the review points range of the Potential rating model.

Now, let's assume that there are 8 questions. Here's the total points for each rating level in the Potential Assessment
rating model.

• Rating Level 1: 8 * 1 = 8 points

• Rating Level 2: 8 * 2 = 16 points

• Rating Level 3: 8 * 3 = 24 points

All these scores from the Potential Assessment rating model map correctly to the review points range in the Potential
rating model. This shows that you need to create 8 questions to rate potential.

Now, consider the rating model configuration shown in this table. The review points range is changed here.
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Potential Assessment
Rating Model Rating
Level

Potential Assessment
Rating Model
Numeric Rating

Potential Rating
Model Rating Level

Potential Rating
Model Review Points

Potential Rating
Model Review Points
Range For Each Level

Final Potential Rating

1
 

1
 

1
 

1
 

0-7
 

1-Low
 

2
 

2
 

2
 

2
 

8-12
 

2-Medium
 

3
 

3
 

3
 

3
 

13-99
 

3-High
 

For this review point range, you need to create 5 questions to rate potential.

Example of Rating Potential Using the Potential
Assessment  
The potential assessment is a questionnaire that calculates potential rating for a worker based on the responses
reviewers provide before a talent review meeting. The potential assessment calculates the total number of points for
each response based on the Potential Assessment rating model.

Talent review reviewers use potential assessment on the Prepare Review Content page. Select My Client Groups >
Talent Review. You create the potential assessment on the Questionnaires page. In the Setup and Maintenance work
area, use the following:

• Offering: Workforce Development

• Functional Area: Talent Review

• Task: Potential Assessment

Settings That Affect Potential Assessment
There are three configurations that affect the ranking score:

• Number of rating levels, and the numeric rating assigned to each level, in the Potential Assessment rating
model

• Number of rating levels, and review points and points range assigned to each level in the Potential Rating
Model

• Number of questions in the Potential Rating (potential assessment) questionnaire

How Potential Rating Is Calculated
The potential assessment contains a set of questions with responses associated with the Potential Assessment rating
model. Each possible response represents one unique rating level in the Potential Assessment rating model. The value
of each response is the same as the numeric rating for the rating level.

Each rating level in the Potential Rating Model is associated with a range of review points.
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When the reviewer completes the potential assessment:

1. The total value of the selected responses is calculated by adding the numeric rating for the rating levels in
Potential Assessment rating model.

2. The calculated total is compared to the range of review points in the Potential Rating Model to identify the
rating level.

3. The final potential rating is the rating level that corresponds to the sum of the review points in the Potential
Rating Model that fit in the range between the From Points and To Points.

Example
In this example:

• The Potential Rating questionnaire contains eight questions.

• The Potential Assessment rating model contains three rating levels, one for each possible response to the
questions. Each rating level has a numeric rating. The responses and their numeric ratings are:

◦ Strongly Agree: 3

◦ Agree: 2

◦ Disagree: 1

• The Potential Rating Model has three rating levels. The table shows the numeric ratings for each rating level
in the Potential Rating Model, the short description that describes the rating level, the review points, and the
points range for each level.

Note:  You must configure all the Potential Rating Model attributes shown in the table to use the potential
assessment.

Numeric Rating for Rating
Level

Short Description Review Points Points Range: From Points Points Range: To Points

1
 

Low
 

1
 

0
 

13
 

2
 

Medium
 

2
 

14
 

20
 

3
 

High
 

3
 

21
 

99
 

Reviewers must answer each question to ensure that the potential assessment is valid. Because the lowest possible
rating value for each question is 1, the minimum score is 8. The maximum score is 24. If the sum of the reviewer's
selections is 16, that corresponds to the points range of 14-20, and the review points level is 2. The associated numeric
rating for the rating level is 2 for that review points level. Therefore, the final potential rating is 2-Medium.

Related Topics
• How do I update existing setup data?
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Configure a Potential Assessment  
This example shows how to configure a potential assessment questionnaire that talent reviewers can use to rate worker
potential before a talent review meeting.

The following table summarizes key decisions for this scenario.

Decisions to Consider In This Example

Which questionnaire should I configure? The delivered Potential Rating questionnaire

How many sections?
 

One
 

How many questions should I create for
the questionnaire?
 

Eight
 

Summary of the Tasks
Configure the Potential Assessment questionnaire.

1. Enter questionnaire basic information.
2. Enter questionnaire contents.
3. Create questions.

Prerequisites
1. Configure the Potential Assessment rating model using the attributes shown in the following table.

Rating Level Name and Short Description Numeric Rating

DISAGREE
 

Disagree
 

1
 

AGREE
 

Agree
 

2
 

STRONGLY_AGREE
 

Strongly Agree
 

3
 

2. Configure the Potential rating model using the attributes shown in the table.

Rating Level Name and Short
Description

Review Points Review Points From
Points

Review Points To Points

LOW
 

Low
 

1
 

0
 

13
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Rating Level Name and Short
Description

Review Points Review Points From
Points

Review Points To Points

MEDIUM
 

Medium
 

2
 

14
 

20
 

HIGH
 

High
 

3
 

21
 

99
 

Entering Questionnaire Basic Information
1. In the Setup and Maintenance work area, use the Potential Assessment task to open the Questionnaires

page.
2. In the Search Results section, select Potential Rating and click Edit to open the Edit Questionnaire: Potential

Rating dialog box.
3. Leave Update Existing Questionnaire selected and click OK to open the Edit Questionnaire Basic Information

page.
4. On the Edit Questionnaire Basic Information page, complete the fields, as shown in this table.

Field Value

Name
 

Potential Rating
 

Status
 

Active
 

Introduction
 

Any
 

5. Click Next to open the Edit Questionnaire Contents page.

Entering Questionnaire Contents
1. On the Edit Questionnaire Contents page, complete the fields, as shown in this table.

Field Value

Section Order
 

Sequential
 

Section Presentation
 

No Sections
 

Page Layout
 

1 Column
 

Maximum Number of Questions per
Page
 

Blank
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2. In the Sections section, click Create to open the Create Section dialog box.
3. Complete the fields, as shown in this table. Use the default values unless otherwise indicated.

Field Value

Name
 

Section 1
 

Description
 

Any
 

Question Order
 

Vertical
 

4. Click OK to return to the Edit Questionnaire Contents page.
5. In the Sections section, in the Section 1 row, complete the fields, as shown in this table.

Field Value

Question Order
 

Vertical
 

Response Order
 

Vertical
 

Creating Questions
1. In the Sections section, select Section 1.
2. In the Section 1: Questions section, click Create to open the Add Questions dialog box.
3. In the Questions section, in the Question field, enter This person is a long-term thinker.
4. In the Response section, in the Presentation field, select Radio Button List.
5. Click Preview to open the Preview dialog box.
6. Click OK to return to the Add Questions dialog box.
7. Click Save to return to the Edit Questionnaire Contents page.
8. Repeat steps 2 through 7 to create seven more questions, using the questions and presentation type shown in

the table.

Question Text Presentation

This person has the ability to lead
others through influence, and not just
authority
 

Radio Button List
 

This person is a creative problem solver
 

Radio Button List
 

This person thrives on new challenges
and delivers results

Radio Button List
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Question Text Presentation

 

This person is a good fit within our
culture
 

Radio Button List
 

This person has an effective network;
both internally and externally
 

Radio Button List
 

This person is self-aware, and strives
for both personal and professional
development
 

Radio Button List
 

This person recognizes the potential in
others
 

Radio Button List
 

9. Click Next to open the Edit Questionnaire Review page.
10. Click the Preview button to open the Preview Potential Rating dialog box.
11. Click OK to return to the Edit Questionnaire Review page.
12. Click Save and Close.

Related Topics
• How You Set Up Potential Assessment

• Guidelines for Configuring a Potential Assessment

• Example of Rating Potential Using the Potential Assessment

FAQs for Potential Assessment  

Can I update an existing potential assessment questionnaire?  
Yes, you can update an existing potential assessment questionnaire.

1. Use the Potential Assessment task available in the Setup and Maintenance work area.
2. In the Potential Rating folder, select the questionnaire you want to edit.
3. Click Edit.
4. If you had selected the delivered Potential Rating questionnaire, select an appropriate option. You can create a

new version of the questionnaire or update the existing questionnaire.
5. Make the changes that you want to.
6. Save and close the questionnaire.
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What happens if I change the potential assessment questionnaire
associated with a Talent Review meeting template?  
When you change the associated potential assessment questionnaire in a Talent Review meeting template, meetings
already created based on the template aren’t affected.

Only new meetings that are created based on the updated template will show the changed potential assessment
questionnaire.

How can I prevent facilitators from viewing the potential
assessments of member of the review population?  
As administrators, you can use Page Composer to hide the View Potential Assessment action on the Talent Review
dashboard.

Note that hiding the View Potential Assessment action won't impact reviewers. They can view potential assessments
of their team members and submit ratings.

Related Topics
• Guidelines for Using Page Composer
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7  Talent Review Tasks and Notes

Talent Review Tasks  
As a facilitator, reviewer, or a Talent Review super user, you can create, assign, and manage tasks for action items arising
from a talent review.

Manage talent review meetings and the associated tasks from the Talent Review work area.

• Facilitators and Talent Review super users need to select My Client Groups >  Talent Review.

• Reviewers need to select My Team >  Talent Review.

Create and Assign Tasks
You can create and assign tasks in these areas:

• Talent Review dashboard: You can use any of these options to manage tasks on the meeting dashboard:

◦ Add Task action: Select any person in the review population and add a task. The person to whom you
add the task is automatically the Associated Worker, and the person's manager is the Assignee. But you
can change this.

◦ Table view of the meeting dashboard: You can see the number of tasks assigned to the members of
the review population in the Tasks column. Click the task count to see the list of tasks associated with the
member of the review population on the Tasks page. When you add or delete a task, the corresponding
count of tasks for the associated worker is updated in the Tasks column.

• Tasks page: Assign a task to any person you have access to; you aren't restricted to assigning tasks to meeting
participants or the review population

In addition to a subject and description, you define the task attributes shown in this table.

Task Detail Description

Associated Worker
 

The person for whom the task is added.
 

Assignees
 

One or more workers who perform the task.
 

Note:
The person's manager is the default assignee.
 

Owners
 

People who manage the task. The meeting facilitator or Talent Review super user is the task owner by
default, but you can add more owners. Owners need not be meeting facilitators, but if the task owners
can't access the Tasks page, they might not be able to manage the task.
 

Task Type
 

The category of the task, such as Preparation and Presentation. Task type values exist in the HRT_
TASK_TYPE lookup. You can add values to suit your business requirements.
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Task Detail Description

 

Due Date
 

Date by when assignees need to complete the task. The default date is one year from the current date.
 

Priority
 

Level of urgency for the task, such as High, Medium, or Low. Priority values exist in the HRT_TASK_
PRIORITY lookup. You can add values to suit your business requirements.
 

Percentage Complete
 

The completion percentage of the task. Owners update the field as the assignee progresses on the
task.
 

Status
 

Assigned or Completed.
 

Start Date
 

Date when work begins for the task.
 

End Date
 

Date when the task is complete.
 

Edit Tasks
You can edit tasks only on the Tasks page and not on the Talent Review meeting dashboard. You can edit any task field,
and reassign and delete tasks. If a task has multiple owners or assignees, then all can view any changes made by one of
them.

Note:  When you edit a task after navigating from the table view of the meeting dashboard, you can’t change the
name of the associated worker.

View Task History
You can view all tasks for all current and past meetings for an associated worker on the Tasks page.

1. In the Tasks section, select the associated worker row.
2. From the Actions menu, select View History.

Related Topics
• Profile Management Lookups

Overview of Alerts for Talent Review Tasks  
Alert notifications for Talent Review tasks can aid task completion.

Facilitators or reviewers can assign tasks to managers and HR specialists when conducting or preparing a Talent Review
meeting. Reminders about these tasks ensure the completion of the tasks:

• Tasks assigned to them or that they now own

• Tasks that are due
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Alerts for Talent Review Tasks
As an administrator, use the Talent Review Tasks Alert template in Alerts Composer to configure notifications related
to Talent Review tasks. This table lists the included alert templates.

Template Effect of enabling

Notification for New Task Owner Notifies task owners about each task of a Talent Review meeting that they're added as an owner

Notification for New Task Assignee Notifies task assignees about each task of a Talent Review meeting that they're assigned

Notification of Aggregated Tasks for
Owner

Notifies new owners about all tasks of a Talent Review meeting in which they've been added as an
owner in the specified number of days

Notification of Aggregated Tasks for
Assignee

Notifies new assignees of all tasks of a Talent Review meeting that they've been assigned in the
specified number of days

Reminder Notification for Task Due Notifies assignees that a task is due in the specified number of days

Note:  All these alerts are disabled by default.

Related Topics
• Overview

Notify Owners and Assignees about Talent Review
Meeting Tasks  
As an administrator, you can configure alerts to send individual or aggregated notifications to managers and HR
specialists when they're assigned a new task for a Talent Review meeting or made the task owner.

Note that for existing tasks, when an HR specialist or a reviewer adds a person as an owner or an assignee, notifications
are sent only if the task isn't complete. Also remember that if an employee is both an owner and an assignee for a task,
the employee gets 2 notifications.

Send Individual Task Notifications to New Task Owners and Assignees
Your organization might want to notify employees every time the employee is assigned a task or made an owner. Here's
how you configure this:

1. Search for and open the Talent Review Tasks Alert template in Alerts Composer.
2. Ensure that it's enabled.
3. Enable these alert templates:

◦ Notification for New Task Owner

◦ Notification for New Task Assignee

4. Click Save and Close.
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Send Aggregated Notification of Tasks to Owners and Assignees
Your organization might not want to send a notification to employees every time they're added as an owner or assignee
to a task associated with a Talent Review meeting. In this case, do these steps:

1. Configure alerts to send an aggregated notification of tasks for a meeting.
2. Run the Send Notification for Talent Review Tasks process.

Note:  To run the Send Notification for Talent Review Tasks process, you need to have the Run Global HR
Processes (PER_RUN_HR_PROCESSES_PRIV) function security privilege.

To configure alerts to send an aggregated notification of tasks for a meeting, do these steps:

1. Go to Tools > Alerts Composer.
2. Search for and select the Talent Review Tasks Alert template.
3. Ensure that it's enabled.
4. To send an aggregated notification to task owners:

a. Disable the Notification for New Task Owner template.
b. Enable the Notification of Aggregated Tasks for Owner template.

5. To send an aggregated notification to task assignees:

a. Disable the Notification for New Task Assignee template.
b. Enable the Notification of Aggregated Tasks for Assignee template.

6. Click Save and Close.

After you configure the alerts template, you need to run the Send Notification for Talent Review Tasks process
regularly to let employees know about all tasks that they're assigned or own for a Talent Review meeting.

1. Go to Tools > Scheduled Processes.
2. Search for and run the Send Notification for Talent Review Tasks process.
3. Specify the number of days in the past that the process needs to check for new task assignees or owners.
4. Schedule the process according to your organization's needs.
5. Submit the process.

When the process completes, you can check these details in the log file:

• Person identifier of the employees who were notified and their role for the task

• Meeting with which the task is associated

• Number of notifications sent

Note that if employees are made an owner or an assignee for tasks of more than one meeting in the specified days, they
receive separate notifications for each meeting.

Related Topics
• Overview

• Submit Scheduled Processes and Process Sets
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Remind Assignees When Talent Review Tasks Are Due  
Your organization might want to send a reminder to task assignees before the tasks are due. This helps the assignees to
prioritize work and complete tasks.

To send task reminders, as administrators, you need to do these steps:

1. Configure the Talent Review Tasks Alert template.
2. Run the Send Reminder for Talent Review Tasks That Are Due process.

Note:  You can run this process only if you've the Run Global HR Processes
(PER_RUN_HR_PROCESSES_PRIV) function security privilege.

Remember that task owners aren't notified about tasks that are due.

Configure Alerts to Send Task Reminders to Task Assignees
Do these steps to configure alerts to send reminders to task assignees:

1. Go to Tools > Alerts Composer.
2. Search for and select the Talent Review Tasks Alert template.
3. Ensure that it's enabled.
4. Ensure that the Reminder Notification for Task Due template is enabled.
5. Click Save and Close.

Run the Send Reminder for Talent Review Tasks That Are Due Process
After you configure the alerts template, you need to run the Send Reminder for Talent Review Tasks That Are Due
process regularly to let task assignees know about tasks that they need to complete for a Talent Review meeting.

1. Go to Tools > Scheduled Processes.
2. Search for and run the Send Reminder for Talent Review Tasks That Are Due process.
3. Specify the number of days before the task due date that the process needs to check for.
4. Schedule the process according to your organization's needs.
5. Submit the process.

When the process completes, you can check these details in the log file:

• Person identifier of the employees who were notified

• Task due date

• Meeting with which the task is associated

• Task title

• Number of notifications sent

Related Topics
• Overview

• Submit Scheduled Processes and Process Sets

57

https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20065436
https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20048442


Oracle Fusion Cloud Talent Management
Implementing Talent Review and Succession Management

Chapter 7
Talent Review Tasks and Notes

Talent Review Notes  
You can create notes for workers in the review population of talent review meetings. You can also create notes about the
meeting.

• Facilitators need to select My Client Groups > Talent Review.

• Reviewers need to select My Team > Talent Review.

To manage notes, select the View Notes option from the Actions menu of a meeting.

Notes use the Feedback feature that's available in person spotlight and person smart navigation. When you view the
feedback for a person, you can identify the notes that were created in a talent review meeting by the name of the
meeting that's displayed in the note.

Create Notes
You can create notes for both the meeting and the workers in the review population.

• On the meeting dashboard, select a worker in the review population and click Add Notes.

• On the Notes page that opens when you select the View Notes option from the Actions menu of a meeting,
you can add notes in these ways:

◦ To add a note about the meeting, in the Meeting Notes section, click Add.

◦ To add a note for a worker:

i. Click the Notes link in the worker row.
ii. In the Notes section, click Add.

• On the Prepare Review Content page, to add a note for a worker in the review population, do this:

a. Select the worker row.
b. From the Actions menu, select View Notes.
c. In the Notes section, click Add.

When you create a note, you need to specify who can see the note. The visibility settings that you see depend on what
your administrator has configured for Talent Review using the Manage Feedback Visibility task. This table shows the
options that are generally available to indicate the note visibility in Talent Review.

Note:  Meeting facilitators can see the notes created for a Talent Review meeting only when they open the meeting.
When they're in the meeting, they can see any meeting note added for all workers in the review population even
if they don't have data access to all workers. But they can't see the meeting note on the Feedback page in person
spotlight if they don't have access to the worker.

Visibility Setting Who Can See the Note

Everyone
 

Any person in the organization. People who aren't participants in the meeting can view the note in the
person spotlight page.
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Visibility Setting Who Can See the Note

Managers Only
 

Managers in the hierarchy of the worker for whom the note is created and the meeting facilitators.
 

Managers and <Worker Name>
 

Managers in the hierarchy of the worker, the meeting facilitators, and the worker for whom the note is
created. The worker can view the note in the person spotlight.
 

Manager, worker, and peers Managers in the hierarchy of the worker, the meeting facilitators, the worker for whom the note is
created, and the peers of the worker. The worker can view the note in the person spotlight.

Only Me
 

Only the author of the note. However, if the facilitator creates the note on the dashboard during the
actual meeting, the participants can see it when the meeting is conducted.
 

Only worker and me
 

Only the author of the note and the worker for whom the note is created.
 

View History
Facilitators can view all notes for all meetings for the members of the review population, including those created by
reviewers.

1. Select the View Notes option from the Actions menu of a meeting.
2. Click the Notes link in the worker row.
3. Select a meeting to view the notes created for that meeting.

Create Reports
You can create reports for notes using Oracle Transaction Business Intelligence (OTBI).
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8  Talent Review Integrations

How Talent Review Works with Profiles, Goals, and
Performance Management  
Talent review integrates with Profiles, Goals Management, and Performance Management. You use talent review
templates to control this integration. Create talent review templates on the Manage Talent Review Templates page.

In the Setup and Maintenance work area, use the following:

• Offering: Workforce Development

• Functional Area: Talent Review

• Task: Configure Talent Review Dashboard Options

This image shows the data integration of Talent Review with Profiles, Goals Management, and Performance
Management.
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Talent Review and Profiles
You can include any of these delivered ratings and their associated rating models from Profiles in a Talent Review
meeting template:

• Performance

• Potential

• Overall Competencies Rating

• Overall Goals Rating

• Impact of Loss

• Risk of Loss

• Talent Score

You can also use custom ratings created in Profiles Talent Review meeting template.

Reviewers rate the review population based on the ratings included in the template. When a facilitator conducts the
meeting, the participants can view the ratings of each worker in the review population on the meeting dashboard. The
facilitator can show how the latest ratings compare with the prior ratings of the workers stored in profiles.

The latest overall performance rating for a worker can come from any of these sources:

• Overall rating in the performance document

• Rating that a participant provides while preparing the review content before the meeting

• Career Planning card

The facilitator can change the ratings of the workers during the meeting. When the facilitator submits the meeting, the
ratings of the workers in the review population is updated in Profiles.

Talent Review and Goals
A facilitator can assign a performance goal or a development goal to a worker in the review population while conducting
a Talent Review meeting. A facilitator can assign a new goal or an existing goal from the goal library. Workers can view
the goals assigned on their performance goal or development goal pages.

Talent Review and Performance Management
You can enable ratings for the performance document sections. If the performance document is configured to do so,
when a performance document is completed, the worker's profile is updated to include these changes made in the
performance document:

• Overall ratings

• Competencies and proficiency rating levels

• Competencies and goals section ratings

When the ratings are enabled, you can configure the talent review template to include overall worker competencies,
overall ratings, and overall goals ratings
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Related Topics
• Enhanced Talent Profiles

• Profile Management Components: How They Work Together

• Rating Models

• Goal Library

Configure a Talent Review Box Assignment Event for
Journeys  
This example shows how to use the condition builder to configure the Box Assignment checklist event.

Let's assume that you want line managers to do these tasks when a member of the review population moves to the Top
Talent box on the on the Talent Review dashboard:

• Include the member in a particular talent pool.

• Add some development goals for the member.

You need to do these tasks to configure the Box Assignment checklist event:

1. Create a Talent Review Box Assignment checklist template.
2. Configure the Box Assignment event.
3. Add tasks for the manager.

Create a Talent Review Box Assignment Checklist Template
1. In Setup and Maintenance, go to the Checklist Templates task.

Tip:  You can also use the Checklist Templates quick action available in My Client Groups.

2. Create a checklist template.
3. On the General tab, specify values as indicated in this table.

Field Value

Name
 

Talent Review Box Assignment
 

Status
 

Active
 

Category
 

A suitable category. For example, Talent Management.
 

4. Click Save.

Configure the Box Assignment Event
1. Click the Actions and Events tab.
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2. In the Configure Events section, click Add.
3. Select Box Assignment in the Name list of values.
4. Click Edit Condition to display the Condition Builder.
5. Click Create Group.
6. Select the values indicated in this table.

Condition Column Value to Select

Attribute
 

Box Assignment Name
 

Operator
 

Equals
 

Operand Type
 

Constant
 

Operand Value
 

Top Talent
 

Note:
The values listed depend on the box assignment values configured in the Talent Review
meeting template.
 

7. Click OK to close the Condition Builder.
8. Click Save.

Add Tasks for the Manager
1. Click the Tasks tab.
2. Click Add Task to add a task.
3. On the Details sub tab, specify values as indicated in this table.

Field Value

Name
 

Add to Pool
 

Status
 

Active
 

Sequence
 

1
 

Performer
 

Line Manager
 

Owner
 

Line Manager
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Field Value

Task Type
 

Application Task
 

Application Task
 

Add to Talent Pool
 

4. Click Save and Close.
5. Click Add Task to add the second task.
6. On the Details sub tab, specify values as indicated in this table.

Field Value

Name
 

Add Development Goals
 

Status
 

Active
 

Sequence
 

2
 

Performer
 

Line Manager
 

Owner
 

Line Manager
 

Task Type
 

Application Task
 

Application Task
 

Add Development Goal
 

7. Click Save and Close to return to the Tasks tab.
8. Click Save and Close.

Related Topics
• How You Configure Events in Journeys

Dispose Talent Review Data  
To meet data protection requirements, as administrators you might need to dispose Talent Review data of terminated
employees. You can do this in the Data Exchange work area.
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You first need to use the Configure Person Information Removal Policies task to create configuration templates. You
can create a template to remove person information of people who are part of a Talent Review meeting in any of these
roles:

• Member of the review population

• Participant

• Facilitator

You then need to enable the template and run the Remove Person Information task.

Create Configuration Template

1. Go to the Data Exchange work area in My Client Groups.
2. In the Remove Person Information section, click Configure Person Information Removal Policies.
3. Click Create to create a template.
4. Specify values for these fields.

Field Description

Name Template name

Code The template code, defaults to the name of the template.
 

Category Business object category. Select Worker.

Description A suitable description to identify the template.

5. Click OK.
6. Ensure that you're on the Components tab.
7. In the Business Objects pane, select Talent Review Meeting.
8. In the Components pane, expand Talent Review Meeting.
9. Select any of these check boxes according to the role of the persons whose information you want to remove.

Check box Role of person to remove

Facilitator Facilitator of Talent Review meetings
 

Participant Participant who can also be a reviewer of Talent Review
meetings

Reviewer
 

Member of review population

10.Click Save and Close.
11. Enable the template.

Results:
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Here’s what happens after the person information removal process of the Talent Review Meeting object completes
successfully:

• You can’t see the workers whose person numbers you specified while running the person information removal
process in the Facilitators, Participants, and Review Population section of Talent Review meetings.

Note:  The process removes terminated workers as meeting facilitators even if they were the only facilitator
for the meeting.

• Reviewers can’t see the terminated workers who were part of the review population when they prepare review
content.

• Facilitators and participants can’t see the terminated workers who were part of the review population on the
meeting dashboard.

• The process doesn't delete the ratings assigned by terminated workers who were Talent Review meeting
participants.

• The process doesn't remove the ratings assigned to the terminated workers either when preparing review
content or when conducting the meeting from Talent Profile.

What to do next

Sometimes the removed terminated workers can be the only facilitators for the Talent Review meeting. You then need to
add a new facilitator for the meeting either as a super user or by using HCM Data Loader. You can edit the meeting only
after you add a facilitator.

Related Topics
• Remove Person Information
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9  Succession Management

Succession Planning  
Succession planning or succession management can help you to identify successors for key employees.

You manage succession plans in the Succession Plans work area. Select My Client Groups > Succession Plans.

Because of the default filters, you can see only active succession plans that you have access to when you view the
Succession Overview page. Clear the filter to also view inactive succession plans.

These are the advantages of using succession plans:

• Ensure a smooth transition to key jobs and positions.

• Identify workers who are ready now, or who can become ready by developing the necessary skills, for jobs and
positions that are likely to become vacant.

• Plan the career development of candidates.

Plan Types
Select from these succession plan types:

• Incumbent: Use this plan type to replace a specific person.

• Job: Use this plan type to identify candidates for a job, such as Business Analyst or Sales Manager.

• Position: Use this plan type to identify candidates for a position, such as Senior Vice President for Sales or
Assistant Marketing Manager.

Plan Incumbents
You can view the incumbents who currently have the same job or position as defined in Job and Position type
succession plans. The succession plan attributes such as business unit and department if specified determine the
incumbents who have the same position or job. You can see the incumbent information on these pages:

• Succession Overview

• Succession Planning tab of person spotlight

• Incumbents section of the succession plan

Note:  You can see only the incumbents that you have access to.

Plan Candidates
Succession plans can have multiple owners from different organizations. So you can include candidates from multiple
organizations in succession plans.

You can add candidates to a succession plan in these ways:

• Search for employees that you can access and add them as candidates.
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• Add external candidates.

• Use Best-Fit feature to find candidates who match the job or position requirements.

Note:  The Best-Fit feature isn't available on mobile devices. You also can't see this option when your
administrator enables adding artificial intelligence suggested candidates.

• Add artificial intelligence suggested candidates.

• Add talent pool members.

You can see these details for each candidate in the Candidates section of a succession plan:

• Date when they were added as a candidate to the plan

• Readiness information

• Status

You can also see the current job title for internal candidates.

You can view these counts for candidates who are also a candidate in other succession plans:

• The total number of plans in which the person is a candidate

• The number of plans that you can access in which the person is a candidate

Click the count link to view the corresponding list of other succession plans in which the person is a candidate.

By default, you can see only the count for the number of plans that you can access. You can't see the count that shows
the total number of plans the person is a candidate on. Your administrator can however use Transaction Design Studio
to show this count.

To find more information about an internal candidate, click the candidate name. The Succession Planning tab in person
spotlight for that candidate opens where you can see these details:

• The succession plans created for that person that you can access

• The succession plans in which the person is a candidate that you can access

• The talent pools in which the person is a member and which you can access

• Risk of Loss, Impact of Loss, and Job Criticality details

You can create or edit external candidates in the External Candidates section of the Succession Overview page. When
creating an external candidate, you need to specify the last name. The other fields such as first name, job title, email,
and phone are optional.

You can search for existing candidates when editing a succession plan or creating a new one. Use the search field in the
Candidates section to do this. You can search by the first name, last name, or both. Initially, you can see 5 candidates
that match the name entered, but you can load more. You can sort the candidates listed.

Note:  You can select only these succession plans when you try to add candidates:
• Plans for which you're a named owner

• Plans in which you have access to the named or inferred incumbent of the plan
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Talent Pools
You can add candidates in a succession plan to an existing talent pool to manage candidate development. The
development goals in a talent pool can prepare candidates for the relevant job or position.

Related Topics
• Examples of Creating Succession Plans

• How Managers Can Work With Succession Plans

• Examples of Access to Nonprivate Succession Plans

• Best-Fit Analysis

How Inferred Incumbents of Succession Plans Decide
Plan Access  
Any person who holds the job or position for which the succession plan is created is an inferred incumbent.

In the automatic plan access method, only the following users can access nonprivate succession plans:

• The named owners of the plan

• Employees who have access to the named or inferred plan incumbents

To decide plan access, the inferred incumbent information for Job and Position type succession plans is stored in the
succession plan incumbent table. This table is automatically updated whenever a new succession plan is created or
when a succession plan is changed. The Succession Plan Incumbents process also updates this table when scheduled.

Attributes Considered to Decide Plan Incumbents
You can refine your succession planning by specifying more attributes. These attributes are considered to identify
the plan incumbents to include in the succession plan incumbent table. This table indicates the attributes that are
considered to identify the incumbents for Job and Position type succession plans.

Plan Type Attributes Considered

Job
 

Business Unit, Job Department, and Job Grade
 

Position
 

Business Unit, Department
 

So, if you specify the job department as Sales for the Director job of a Job type succession plan, only suitable
employees from the Sales department are included as incumbents in the succession plan incumbent table. Employees
from other departments won't be included as plan incumbents.

Succession Plan Incumbents Process
Employee movement, such as changes in job roles or transfers, can also affect plan access. For example, if an employee
is transferred to another department and reports to a new manager, the former manager's access to the plans in which
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the employee is a named or an inferred incumbent should be revoked. Instead, the current manager should now be
given access to the plans in which the employee is a named or an inferred incumbent. To update the succession plan
incumbent table for these changes, a user with an implementor or administrator role should schedule the Succession
Plan Incumbents process.

You can schedule the Succession Plan Incumbents process daily, weekly, and so on, based on the frequency of changes
to your organizational structure. For example, if new employees are only inducted monthly and if your organization's
attrition rate isn't high, you can schedule the Succession Plan Incumbents process on a monthly basis.

To run the Succession Plan Incumbents process:

1. On the Scheduled Processes Overview page, click Schedule New Process.
2. In the Schedule New Process dialog box, from the Name list, select the Succession Plan Incumbents process,

and click OK.
3. Optionally, in the Process Details dialog box, change the process schedule to one that's appropriate for your

organization and define notifications.

Note:  By default, the Succession Plan Incumbents process is scheduled as soon as possible.

4. In the Process Details dialog box, click Submit.

Related Topics
• What are scheduled processes?

• Submit Scheduled Processes and Process Sets

Succession Management Lookups  
This topic identifies common lookups for the Succession Management functional area. You can update the lookup that
has an extensible configuration level as appropriate to suit your enterprise requirements.

You manage the succession management lookups by using the Succession Management Lookups task in the Setup
and Maintenance work area.

Succession Management Lookups
This table provides information about succession management lookups.

Lookup Type Description Configuration Level

HRM_READINESS_CATEGORY
 

The estimated time before a candidate is ready
to move into a job or position. For example,
 the readiness categories can be one of these:
Ready now, Ready in 1-2 years, and Ready in
3-4 years. You must add lookups or you can
use only the delivered values Ready now and
No readiness available.
 

Extensible
 

HRM_SUCC_CAND_STATUS
 

The status of the succession plan candidate:
 

System
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Lookup Type Description Configuration Level

• Active: The employee is an active
candidate for the plan.

• Inactive: The employee is no longer
considered a plan candidate.

HRM_SUCC_PLAN_STATUS
 

The status of the succession plan:
 

• Active: The succession plan is still needed
and is valid.

• Inactive: The succession plan is no longer
needed.

System
 

HRM_SUCC_PLAN_TYPE
 

The type of the succession plan:
 

• Incumbent: Succession plan for replacing
a specific employee.

• Job: Succession plan for a particular job
role, for example, Systems Analyst.

• Position: Succession plan for a particular
position, for example, Executive Vice
President-Sales.

System
 

Descriptive Flexfields for Succession Management  
To add company-defined attributes, for example more information about succession plans or candidates, use
descriptive flexfields for an Oracle Fusion Cloud Succession Management entity. You can use descriptive flexfields to
define validation and display properties.

Defining Descriptive Flexfield Segments
Use the Manage Descriptive Flexfields task to define a segment for a descriptive flexfield for the succession
management business process. You can add more information related to these succession management entities, such
as the succession plan details and candidates.

Two descriptive flexfields are available in the succession management business process.

Descriptive Flexfield Description

HRM_PLANS
 

Fields for succession plan details that appear in the Plan Info section of a succession plan.
 

HRM_PLAN_CANDIDATES
 

Fields for candidate details that appear in the Candidates section of a succession plan.
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Related Topics
• Overview of Descriptive Flexfields

• Overview of Flexfields

Set Up Suggested Successor  
When you enable Artificial Intelligence (AI) based candidate suggestions for succession plans, succession plan owners
can view suitable candidates to include in the succession plan.

Before you start
First, your organization needs to ensure that these tasks are completed:

• Migrate to Enhanced Talent Profiles.

• Set up job model profiles and person profiles. Associate job model profiles with jobs.

• Set up position profiles. Associate position profiles with job model profiles.

• Employees need to complete their talent profiles.

• Associate employees with a job that has a well-defined job model profile.

• Activate AI apps and ingest data.

• Activate AI Talent Best Match feature.

Configure Profile Options
You need to configure profile options related to the Suggested Successor feature to view AI based candidate
suggestions. Use the Manage Administrator Profile Values task in the Setup and Maintenance work area to configure
the values of the profile options listed in this table.

Profile Option Code Profile Option Name Value to Set Effect of Enabling

ORA_HRM_ENABLE_AI_
CANDIDATE_RECOMMENDATIONS

AI-Suggested Candidate Enabled Y Users can add AI suggested
candidates to succession plans.

ORA_HRM_AI_CANDIDATE_
RECOMMENDATIONS_LIMIT

Maximum Number of AI-
Suggested Candidates to Show

A number less than 50 The number of candidate
suggestions shown to users
corresponds to the value specified.

Note:  The default value is 5.
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Related Topics
• Welcome to Oracle AI Apps for Talent Management

• Ingestion Steps for AI Apps Features

• Synchronize Talent Data for AI Recommendations

• Creating Instances of a Model Profile

• Person Profile

• Create and Edit Profile Options

Data Used for AI-Based Candidate Suggestions  
To suggest suitable candidates for succession plans, the Best Successors feature compares the candidate's person
profile attributes with the job model profile attributes of the plan's job, or the job associated with the plan’s position or
plan incumbent.

Person Profile Data
This table lists the Person Profile data used by Oracle AI Apps matching algorithms to provide succession plan candidate
suggestions.

Profiles Content Type Content Items

Profile Description
 

Competencies Competency
 

Education • Degree

• Highest Education Level

• Major

• Minor

Licenses and Certifications License or Certificate
 

Honors or Awards Honor or Award
 

Skills • Skill

• Description

• Specialty

Work Preferences • Travel Domestically

• Travel Internationally

• Willing to Relocate
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Model Profile Data
This table lists the Model Profile data used by Oracle AI Apps matching algorithms to provide succession plan candidate
suggestions.

Profiles Content Type Content Items

Profile • Name

• Description

• Qualifications

Job Description N/A

Job Responsibility N/A

Competencies Competency Name
 

Education • Degree

• Major

Certifications • License or Certification Name

• Title

Skills • Skill

• Description

• Specialty

How You Enable Succession Organization Charts  
To allow users to view succession organization charts, as administrators you need to enable some profile options and
grant a privilege. You need to run the Succession Plan Incumbents process. Your organization should have migrated to
Enhanced Talent Profiles.

Profile Options to Enable Succession Organization Charts
Use the Manage Administrator Profile Values task in the Setup and Maintenance work area to manage profile options.
You need to enable the profile options listed in this table at Site level for users to view succession organization charts.

Profile Option Code Profile Option Name Required Value

HCM_RESPONSIVE_PAGES_ENABLED Mobile-Responsive HCM Pages Enabled Y

HRM_SUCCESSION_RESPONSIVE_ENABLED Mobile-Responsive Succession Planning Page
Enabled

Y
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Profile Option Code Profile Option Name Required Value

ORA_HRM_ENABLE_SUCCESSION_ORG_
CHART

Succession Organization Chart Enabled Y

Privilege to View Succession Organization Charts
The users who need to use succession organization charts need to have a role that inherits the Use REST Service –
Succession Org Charts REST aggregate privilege. After you add this privilege, you must regenerate the grants for the
data role.

Succession Plan Incumbents Process
You need to schedule the Succession Plan Incumbents process regularly to ensure that these details shown on the
succession organization chart are the latest:

• Succession plan count that users see for each direct report on the Directs tab

• The count users see on the Succession Plans tab and the succession plans displayed for the selected person

For more information about scheduling this process, see the How Inferred Incumbents of Succession Plans Determine
Plan Access topic in this guide.

Related Topics
• Journey Profile Options

• Run the Regenerate Data Security Grants Process

FAQs  

What happens if I remove a readiness category lookup?  
If the level is in use for succession plan candidates or talent pool members, their readiness level changes to No
readiness available. Plan or pool owners can select a different readiness level for affected workers.

How can I set a default plan type or control the order of plan types
in the succession plan type list?  
To control the display order of the Plan Type list of values, change the values in the Display Sequence column of the
HRM_SUCC_PLAN_TYPE lookup codes.

1. On the Manage Succession Management Lookups page, search for the HRM_SUCC_PLAN_TYPE lookup.
In the Plan Type list of values, the options are arranged in ascending order of their Display Sequence value.

2. Set the Display Sequence value of the default Plan Type option to 1. For example, if you often create
succession plans of Position type, you can set its Display Sequence value to 1.
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Tip:  If you use only one plan type, set its Display Sequence value to 1. Then use Oracle Page Composer to configure
the Plan Type field as a read-only field.

How can I show incumbents for existing Job and Position type
succession plans?  
You need to run the Succession Plan Incumbents process at least once to show incumbents for existing Job and Position
type succession plans.

How can I hide the Incumbents section and the incumbents listed
on the Succession Overview page?  
As administrators use Transaction Design Studio to hide the Incumbents section and the incumbents listed on the
Succession Overview page.

1. Enable a sandbox and then edit your pages at the Site level.
2. Open HCM Experience Design Studio.
3. Select the Transaction Design Studio tab.
4. From the Action list, select Succession Plans.
5. Add a rule.
6. Enter the basic details.
7. From the Data Source list in the Available Attributes section, select Plan Info.
8. Set the value of the Incumbents attribute to Not visible.
9. Click Save and Close.

How can I hide the option to add talent pool members as
succession plan candidates?  
The option to add talent pool members as succession plan candidates is available by default. But as an administrator,
you can hide this using Transaction Design Studio.

1. Enable a sandbox and then edit your pages at the Site level.
2. Open HCM Experience Design Studio.
3. Select the Transaction Design Studio tab.
4. From the Action list, select Succession Plans.
5. Add a rule.
6. Enter the basic details.
7. From the Data Source list in the Available Attributes section, select Plan Info.
8. Set the value of the Add Talent Pool Members attribute to Not visible.
9. Click Save and Close.
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How can I hide the option to add AI suggested succession plan
candidates?  
The option to add AI suggested succession plan candidates is available by default. But as an administrator, you can hide
this using Transaction Design Studio.

1. Enable a sandbox and then edit your pages at the Site level.
2. Open HCM Experience Design Studio.
3. Select the Transaction Design Studio tab.
4. From the Action list, select Succession Plans.
5. Add a rule.
6. Enter the basic details.
7. From the Data Source list in the Available Attributes section, select Plan Info.
8. Set the AI Suggested Candidates attribute value to Not visible.
9. Click Save and Close.

Succession Management Alerts  

How You Configure Alerts for Succession Plans  
As an administrator, you might want to alert owners of a succession plan about assignment changes of candidates or
incumbents.

Use the Succession Plan Assignment Change Alert templates in Alerts Composer to configure alerts for succession
plans.

These alerts can help plan owners decide if they need to update the succession plans. For example, if a candidate
moves to a role that's different from the plan role, the plan owner can remove that candidate and add other candidates
to the succession plan after receiving the alert notification.

By default, all the succession plan related alerts are disabled. You need to enable the alert for users to receive the
notification.

Note:  Although you can add new templates in Alert Composer for succession plans, these new templates won't
trigger any notifications.

Alerts for Assignment Changes
You can configure alerts for these assignment changes:

• A candidate's job changes to the job specified in the succession plan.

• A candidate moves to a job that's different from the job specified in the succession plan.

• The plan incumbent moves to a different role.
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• A candidate moves to a position that's different from the position specified in the succession plan.

• A candidate's position changes to the position specified in the succession plan.

• A candidate moves to a role different from the plan incumbent's role.

• A candidate moves to a job that's the same as the plan incumbent's job.

Allowed Actions for Succession Plan Alerts Templates
The succession plans alert template is extensible. This table lists the actions that you can do with the template.

Action Can Do?

Disable the delivered alerts.
 

Yes
 

Change the text of the subject line and the
message in the alert.
 

Yes
 

Change the expressions used in the
subject line or message.
 

No
 

Delete the delivered template.
 

No
 

Change the template name or the
communication method.
 

No
 

Related Topics
• Overview

How You Send Succession Alerts on Role Change Effective Date  
Your organization might want to notify plan owners about incumbent and candidate role changes after they become
effective. This enables succession plan owners to update succession plans according to the current roles of the
incumbent or candidates.

If the assignment changes are effective on or before the current date, then alerts are sent to the plan owners
automatically.

But for future-dated assignment changes, you need to schedule the Notify Plan Owners About Candidate and
Incumbent Assignment Changes That Are Now Effective process regularly. This ensures that alerts are sent for
assignment changes that become effective on or before the date the process is run. Note that to run this process, you
need to have a role that inherits the Run Global HR Processes function security privilege.

After You Run the Process
Here's what happens after the Notify Plan Owners About Candidate and Incumbent Assignment Changes That Are
Now Effective process runs successfully:

• Owners receive notifications on the day these role changes become effective if the process is run daily:
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◦ Plan incumbent moves to a different role

◦ A candidate moves to the plan role

◦ A candidate moves to a role that's different from the plan role

Note:  Owners receive notifications only if all these conditions are true:

◦ Alerts are enabled using the Succession Plan Assignment Change Alert templates in Alerts
Composer.

◦ Alerts are enabled in the Alerts section of the succession plan.

◦ Notifications are enabled for the owners in the Owners section of the succession plan.

• When owners view a succession plan, they see banners for the effective role changes of incumbents and
candidates.

• Processed notification records for the incumbent and candidate role changes that are older than 90 days are
deleted.

Related Topics
• Submit Scheduled Processes and Process Sets

Succession Management Alerts FAQ  

How can I hide the Alerts section in a succession plan?  
You use Transaction Design Studio to hide the Alerts section in a succession plan and the check boxes in the section.

1. Enable a sandbox and then edit your pages at the Site level.
2. Open HCM Experience Design Studio.
3. Select the Transaction Design Studio tab.
4. From the Action list, select Succession Plans.
5. Add a rule.
6. Enter the basic details.
7. From the Data Source list in the Available Attributes section, select Plan Info.
8. To hide the Alerts section, set the Alerts attribute value to Not visible.
9. To hide the check boxes that control alerts for succession plans, set these attributes to Not visible.

◦ Send alerts when candidates move to roles that are different from the plan role

◦ Send alerts when candidates move to the plan role

◦ Send alerts when the incumbent changes roles

10. Click Save and Close.
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Succession Plan Deep Links  

Overview of Succession Plan Deep Links  
You can use deep links to navigate directly to the succession plan pages. You can also embed succession plan deep links
in reports or other third party applications and edit or open specific succession plans.

Remember that you need to have access to the Succession Overview page to use the succession plan deep links.

Deep Links for Navigation
You can find the succession plan related deep links on the Deep Links page. Use only the deep links listed in this table
for navigating to a succession plan page.

Deep Link Navigates To

Responsive Succession Overview
 

Succession Overview
 

Responsive Create Succession Plan
 

Create Succession Plan
 

The Edit Succession Plan deep link requires the succession plan ID as a parameter. So, we recommend that you don't
use the Edit Succession Plan deep link to navigate to a succession plan page.

Deep Link for Editing Succession Plan
Use the standard deep link URL listed in this table to edit a succession plan based on your security access.

URL Type URL

Standard Deep Link URL
 

https://<hostname>/fscmUI/faces/deeplink?objType=SUCCESSION_
PLAN&action=EDIT&objKey=pPlanId=@{PLAN_ID}
 

Note that you need to pass the succession plan ID as a parameter to open the corresponding succession plan.
Remember that you need to have access to the succession plan that you're trying to edit. Also what you can edit on the
succession plan page depends on the type of owner you're for the plan. An owner of Administrator type can perform all
actions on the succession plan. But an owner of Candidate Manager type can't perform certain actions such as adding
plan owners.

This table describes the expected behavior when you try to use the edit succession plan deep link.

User's Access Level Expected Behavior

You've access to the Succession Overview
page.
 

You can edit the succession plan. When you save or cancel your changes, you'll go to the Succession
Overview page.
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User's Access Level Expected Behavior

You've the privilege to edit a succession
plan.
 

You've access to the Succession Overview
page.
 
But you don't have the privilege to edit a
succession plan.
 

You'll go to the Succession Overview page.
 

You don't have access to the Succession
Overview page.
 
But you've the privilege to edit a
succession plan.
 

You'll see a blank page.
 

You don't have access to the Succession
Overview page.
 
You don't have the privilege to edit a
succession plan.
 

You'll see a blank page.
 

Related Topics
• Deep Links

Embed the Edit Succession Plan Deep Link in an Analysis  
This example shows how to embed the edit succession plan deep link in an Oracle Transactional Business Intelligence
(OTBI) analysis.

This table summarizes key decisions for this scenario.

Decisions to Consider This Example

What type of URL should I embed?
 

Standard Deep Link URL
 

For which column should I add an
interaction?
 

Plan ID
 

To edit a succession plan directly from an OTBI analysis:

1. Create an analysis that includes the Plan ID as a column.
2. Edit the analysis.
3. Add a drill-down link for the Plan ID column.
4. Save the analysis.
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Add a Drill-Down Link
1. Edit an existing analysis that has the Plan ID attribute as a column.
2. Go to the Criteria tab.
3. In the Plan ID column, click Settings > Column Properties.
4. Click the Interaction tab.
5. Select the values indicated in this table.

Field Value

Primary Interaction
 

Default (Drill)
 

Value
 

Action Links
 

6. Click Add Action Link.

You see the New Action Link dialog box.
7. In the Link Text field, type Edit Plan.
8. Click the Create New Action icon.
9. Select Navigate to a Web Page.

You see the Create New Action dialog box.
10. Enter URL in this format:

https://<hostname>/fscmUI/faces/deeplink?objType=SUCCESSION_PLAN&action=EDIT&objKey=pPlanId=@{PLAN_ID}

11. Click Define Parameters.
12. Add a new parameter.
13. In the third row, specify the values shown in this table.

Column Value

Name
 

PLAN_ID

 

Prompt
 

Any suitable value, say Plan ID
 

Value
 

Column Value and then select the Plan ID column
 

14. Select the Hidden check box for all the rows.
15. Clear the Optional check box for all the rows.
16. Click Options.
17. In the Action Options dialog box, select the Open In New Window check box.
18. Click OK to close the Action Options dialog box.
19. Click OK to close the Create New Action dialog box.
20. Click OK to close the New Action Link dialog box.

84



Oracle Fusion Cloud Talent Management
Implementing Talent Review and Succession Management

Chapter 9
Succession Management

21. In the Column Properties dialog box of the Plan ID column, click the Data Format tab.
22. Select the Override Default Data Format check box and then specify the value for Treat Number As field as

Number.

Note:  You need to override the default data format only for the Plan ID column.

23. Click OK to close the Column Properties dialog box.

Succession Plan Notes  

Contextual Notes in Application Pages  
Enhance Talent Management application pages using the Notes resource catalog component for persons and objects
using Oracle Page Composer.

The Notes feature is similar to the Feedback feature in employee's Person Spotlight and Performance Document. The
Contextual Notes is an extension of the existing Anytime Feedback feature.

You can embed the Notes component on persons and objects using Oracle Page Composer. The Notes component
appears with the title, Feedback or Notes, based on the component configuration, Person Notes and Object Notes.

You can create and share notes about employees by configuring the Notes resource catalog component in the following
Talent Management scenarios:

• Notes for an employee in the context of an employee's performance goal

• Notes for an employee in the context of an employee's development goal

• Notes for an employee in the context of an employee's career development

• Notes when you explore roles in the context of role details page

You can create and share object notes by configuring the Notes resource catalog component in the following Talent
Management scenarios:

• Notes for a talent review meeting

• Notes for a succession plan

• Notes for a talent pool

Related Topics
• Implementing Contextual Notes in Oracle HCM Cloud Talent Management (Doc ID 2375556.1) on My Oracle

Support

Add an Object Note to a Succession Plan  
Succession plan owners and other HR specialists want to add a note to a succession plan. They also want to restrict the
visibility of the notes to only themselves as the notes might contain confidential information.

This table summarizes the decisions that you need to make as an application implementor.
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Decisions to Consider Who Makes the Decision In This Example

Which Notes component can I add to a
succession plan?
 

Application implementor
 

Object notes
 

Should I change the default visibility setting of
the object Notes component?
 

Plan owners and other HR specialists who can
access the plan
 

Yes. Must change the default Everyone visibility
setting to Only Me.
 

This worked example describes these tasks that need to be done to add the Notes resource catalog component to a
responsive succession plan page:

1. Add the Notes resource catalog component to a succession plan.
2. Create notes for a succession plan.

Before You Add the Notes Component
1. Sign in the application as a user with configuration privileges.
2. Activate a sandbox that has Page Composer tool enabled.

Add a Notes Component
1. Open a responsive succession plan page.
2. On the Settings and Actions menu, click Edit Pages.
3. Ensure that the Edit Layer is Site.
4. Select the Structure tab.
5. Select the region where you want to add the note.
6. In the Source window, select the panelGroupLayout indicated for the page region:

◦ Plan Info section: Select the panelGroupLayout that encloses all the existing panelCollectionEdit
components.

◦ Other regions: Select the panelGroupLayout that's at a level lower than the FacetWrapper level.

7. In the Source window, click the Add icon.
8. In the Add Content dialog box, click Add adjacent to Notes.
9. Close the Add Content dialog box.

10. In the Source window, select the Notes component and edit its properties.
11. In the Component Property dialog box, configure the contextual parameters as shown in this table.

Parameter Expression

Object Type
 

SUCCESSION_PLAN_NOTE

 

Object ID
 

#{bindings.PlanId.inputValue}

 

12. Configure the display options.
13. Click Apply.
14. Click OK.
15. Click Close to stop editing the page.
16. Publish the sand box.
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Create a Note
After the application implementor adds the notes component to a succession plan, it's available in all plans.

A plan owner or an HR Specialist who can access the succession plan can create a note about the succession plan.

1. Navigate to the Succession Plans overview page.
2. Edit the plan for which you want to create a note.
3. Click the Notes component.
4. In the Notes page, click Add.
5. From the Who can see my note list, select Only Me.
6. Add the notes text.
7. Save the note.

Related Topics
• Add and Hide Components Using Page Composer

Succession Management Integrations  

How Succession Plans, Talent Pools, and Talent Reviews Work
Together  
Succession plans, talent pools, and talent review meetings together support the development of selected workers to
meet enterprise goals or fill key roles.

This table shows how you as an HR specialist can access these work areas.

Work Area Navigation

Succession Plans
 

My Client Groups > Succession Plans
 

Talent Pools
 

My Client Groups > Talent Pools
 

Talent Review
 

My Client Groups > Talent Review
 

Succession Plans with Talent Pools
You can select members from talent pools that you own and add them as candidates to succession plans for which you
are a candidate manager. This way, you can enhance your succession planning by selecting appropriate candidates for a
specific job or position.

For example, your current sales director plans to retire after a year. You can plan for the succession in this way:

1. Create a succession plan for the Sales Director job.
2. Create a talent pool of sales managers.
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3. Assign development goals to this talent pool to groom the sales managers for the Sales Director job.
4. Edit the Sales Director succession plan. Add selected managers from the sales managers' talent pool as

succession plan candidates.

Succession Plans and Talent Pools with Talent Review Meetings
You can use succession plans and talent pools with Talent Review meetings in these ways:

• When you set up a talent review meeting, you can associate succession plans and talent pools that you can
access with the meeting.

• When you create a talent review meeting, you can add members of a talent pool that you can access to the
review population of the meeting. This way you can discuss the potential of the talent pool members and rate
them during talent review meetings.

• When you conduct the talent review meeting, you can add members of the review population to succession
plans and talent pools associated with the meeting. You can also create succession plans and talent pools from
the meeting dashboard.

Note:  A succession plans super user can access all succession plans. Similarly, a talent pools super user can access all
talent pools.

Related Topics
• Talent Review

• Succession Planning

• Talent Pools

Configure a Succession Readiness Event for Journeys  
This example shows how to use the condition builder to configure the Succession Readiness checklist event.

Let's assume you want to assign these tasks as an administrator to managers when a candidate is ready to move to the
role associated with a succession plan:

• Create training plans for the candidate.

• Add development goals for the candidate.

You need to do these tasks to configure the Succession Readiness checklist event:

1. Create a succession readiness checklist template.
2. Configure the Succession Readiness event.
3. Add tasks for the manager.

Create a Succession Readiness Checklist Template
1. In Setup and Maintenance, go to the Checklist Templates task.

Tip:  You can also use the Checklist Templates quick action available in My Client Groups.

2. Create a checklist template.
3. On the General tab, specify values as indicated in this table.
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Field Value

Name
 

Succession Readiness
 

Status
 

Active
 

Category
 

A suitable category. For example, Talent Management.
 

4. Click Save.

Configure the Succession Readiness Event
1. Click the Actions and Events tab.
2. In the Configure Events section, click Add.
3. Select Succession Readiness in the Name list of values.
4. Click Edit Condition to display the Condition Builder.
5. Click Create Group.
6. Select the values indicated in this table.

Condition Column Value to Select

Attribute
 

Candidate Readiness
 

Operator
 

Equals
 

Operand Type
 

Constant
 

Operand Value
 

Ready Now
 

7. Click OK to close the Condition Builder.
8. Click Save.

Add Tasks for the Manager
1. Click the Tasks tab.
2. Click Add Task to add a task.
3. On the Details sub tab, specify values as indicated in this table.

Field Value

Name
 

Create Training Plan
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Field Value

Status
 

Active
 

Sequence
 

1
 

Performer
 

Line Manager
 

Owner
 

Line Manager
 

Task Type
 

Manual Task
 

4. Click Save and Close.
5. Click Add Task to add the second task.
6. On the Details sub tab, specify values as indicated in this table.

Field Value

Name
 

Add Development Goals
 

Status
 

Active
 

Sequence
 

2
 

Required
 

Select the check box.
 

Performer
 

Line Manager
 

Owner
 

Line Manager
 

Task Type
 

Application Task
 

Application Task
 

Add Development Goal
 

7. Click Save and Close to return to the Tasks tab.
8. Click Save and Close.

Related Topics
• How You Configure Events in Journeys
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Dispose Succession Management Data  
To meet data protection requirements, as administrators you might need to dispose succession plan data of terminated
employees. You can do this in the Data Exchange work area.

You first need to use the Configure Person Information Removal Policies task to create configuration templates. You
can create a template to remove person information of people who are part of a succession plan in any of these roles:

• Candidate

• Plan owner

You then need to enable the template and run the Remove Person Information task.

Create Configuration Template
1. Go to the Data Exchange work area in My Client Groups.
2. In the Remove Person Information section, click Configure Person Information Removal Policies.
3. Click Create to create a template.
4. Specify values for these fields.

Field Description

Name Template name

Code The template code, defaults to the name of the template.
 

Category Business object category. Select Worker.

Description A suitable description to identify the template.

5. Click OK.
6. Ensure that you're on the Components tab.
7. In the Business Objects pane, select Succession Plan.
8. In the Components pane, expand Succession Plan.
9. Select any of these check boxes according to the role of the persons whose information you want to remove.

Check box Role of person to remove

Succession Plan Candidate Candidate in a succession plan
 

Succession Plan Owner Owner of a succession plan

10.Click Save and Close.
11. Enable the template.

Results:
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Here’s what happens after the person information removal process of the Succession Plan object completes
successfully:

• The terminated workers are removed from all succession plans in which they were candidates.

• The candidate readiness data for the terminated workers entered in succession plans is removed.

• These counts are updated for the affected succession plans:

◦ Plan candidate

◦ Readiness

◦ Interim successor

• The terminated workers are removed from all succession plans in which they were owners, even if they were the
sole owner.

What to do next
If the removed terminated workers were the only owners of a succession plan, you need to add a new plan owner either
as a super user or by using HCM Data Loader.

Related Topics
• Remove Person Information
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10  Talent Pools

Talent Pools  
Talent pools are groups used by organizations to categorize people based on criteria such as performance, potential,
or functional area. For example, an organization can group people based on their potential as Early Talent, Promising
Talent, and High Potential.

A person can be a member of more than one talent pool. For example, an employee can be a member of both Promising
Talent and Mid-Management talent pools.

Pool Details
You need to specify these details for a talent pool:

• Name: Enter a name that uniquely identifies or describes the pool.

• Status: By default, all talent pools are active. You can change the status to inactive if you don't want the talent
pool to be added to a succession plan or talent review meeting.

You can mark a talent pool as a private pool. If you do so, then only the named owners can access the private pool.
If you don't mark a talent pool as a private pool, then talent pool security profiles determine who can access the
nonprivate pool.

The person who creates the talent pool is added by default as the owner of the pool. But you can select and add other
owners.

You can also specify these attributes to define the scope of the talent pool:

• Job

• Grade

• Job profile

• Job family

• Department

• Business unit

• Position

Note:  These attributes aren't available by default. Your administrator needs to use Transaction Design Studio to show
these attributes.

Members
You can add talent pool members in any of these ways:

• Search for and select employees.

• Use the Best-Fit feature to add members to a talent pool.
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On the Find Best Fit page, you select a model profile, and specify the priority for each content section. By
default, the best-fit analysis results show all profiles that have 90% match or greater than the selected source
profile. But you can change the percentage of match that you want.

Note:  The Best-Fit feature isn't available on mobile devices.

• Add members from an analysis.

Note:  You can see the option to add talent pool members from an analysis only if your administrator has
specified the file path in the Default Reports Folder for Selecting Talent Pool Members profile option.

For each member of the talent pool, you can see these details:

• Status

• Date they were added as a member

You can also identify members who have inactive assignments.

When creating or editing talent pools, you can search for existing pool members. Use the search field in the Members
section to do this. You can search by the first name, list name, or both. Initially, you can see 5 members that match the
name entered, but you can load more. You can sort the members listed.

Tip:  Did you know that for each member in the pool, you can record your assessment of the risk and impact of the
worker leaving the enterprise? You can't see these attributes by default. Your administrator needs to use Transaction
Design Studio to show these attributes.

Talent Pool Goals
If you're using Career Development, talent pool owners can add development goals to the talent pool. These goals
appear in the development plan of each member of the talent pool.

Related Topics
• How Succession Plans, Talent Pools, and Talent Reviews Work Together

• How You Use Development Goals in Talent Pools

• Transaction Design Studio

Descriptive Flexfields for Talent Pools  
To add company-defined attributes, for example more information about talent pools or talent pool members, use
descriptive flexfields for the talent pools entity.

Defining Descriptive Flexfield Segments
Use the Manage Descriptive Flexfields task to define a segment for a descriptive flexfield for talent pools. You can add
more information related to these talent entities, such as the talent pool details.
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There are two descriptive flexfields available for talent pools.

Descriptive Flexfield Description

HRT_POOLS_B
 

Fields for talent pool details that appear in the Pool Info section of a talent pool page.
 

HRT_POOL_MEMBERS
 

Fields for member details that appear in the Members section of a talent pool page.
 

Related Topics
• Overview of Descriptive Flexfields

• Overview of Flexfields

Overview of Talent Pool Deep Links  
You can use deep links to navigate directly to the talent pool pages. You can also embed talent pool deep links in reports
or other third party applications and edit or open specific talent pools.

Remember that you need to have access to the Talent Pools overview page to use the talent pool deep links.

Deep Links for Navigation
You can find the talent pool related deep links on the Deep Links page. Use only the deep links listed in this table for
navigating to a talent pool page.

Deep Link Navigates To

Responsive Talent Pools Overview
 

Talent Pools page
 

Responsive Create Talent Pool
 

Create Talent pool page
 

The Edit Talent pool deep link requires the talent pool ID as a parameter. So we recommend that you don't use this deep
link to navigate to a talent pool page.

Deep Links for Editing Talent pool Pages
Use the standard deep link URL listed in the table to edit talent pool pages.

URL Type URL

Standard Deep Link URL
 

https://<hostname>/fscmUI/faces/deeplink?objType=TALENT_
POOL&action=EDIT&objKey=pPoolId=@{POOL_ID}
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Note that you need to pass the talent pool ID as a parameter to open the corresponding talent pool page. Also
remember that you need to have access to the talent pool that you're trying to edit.

This table describes the expected behavior when you try to use the edit talent pool deep link.

User's Access Level Expected Behavior

You've access to the Succession Overview
page.
 
You've the privilege to edit a talent pool.
 

You can edit the talent pool. When you save or cancel your changes, you'll go to the Succession
Overview page.
 

You've access to the Succession Overview
page.
 
But you don't have the privilege to edit a
talent pool.
 

You'll see a blank page.
 

You don't have access to the Succession
Overview page.
 
But you've the privilege to edit a talent
pool.
 

You'll see a blank page.
 

You don't have access to the Succession
Overview page.
 
You don't have the privilege to edit a talent
pool.
 

You'll see a blank page.
 

Related Topics
• Deep Links

Embed the Edit Talent Pool Deep Link in an Analysis  
This example shows how to embed the edit talent pool deep link in an Oracle Transactional Business Intelligence (OTBI)
analysis.

This table summarizes key decisions for this scenario.

Decisions to Consider This Example

What type of URL should I embed?
 

Standard Deep Link URL
 

For which column should I add an
interaction?
 

Pool ID
 

96

https://www.oracle.com/pls/topic/lookup?ctx=fa24b&id=s20059100


Oracle Fusion Cloud Talent Management
Implementing Talent Review and Succession Management

Chapter 10
Talent Pools

To edit a talent pool directly from an OTBI analysis:

1. Create an analysis that includes the Pool ID as a column.
2. Edit the analysis.
3. Add a drill-down link for the Pool ID column.
4. Save the analysis.

Add a Drill-Down Link
1. Edit an existing analysis that has the Pool ID attribute as a column.
2. Go to the Criteria tab.
3. In the Pool ID column, click Settings > Column Properties.
4. Click the Interaction tab.
5. Select the values indicated in this table.

Field Value

Primary Interaction
 

Default (Drill)
 

Value
 

Action Links
 

6. Click Add Action Link.

You see the New Action Link dialog box.
7. In the Link Text field, type Edit Pool.
8. Click the Create New Action icon.
9. Select Navigate to a Web Page.

You see the Create New Action dialog box.
10. Enter URL in this format:

https://<hostname>/fscmUI/faces/deeplink?objType=SUCCESSION_PLAN&action=EDIT&objKey=pPoolId=@{POOL_ID}

11. Click Define Parameters.
12. Add a new parameter.
13. In the third row, specify the values shown in this table.

Column Value

Name
 

POOL_ID

 

Prompt
 

Any suitable value, say Pool ID
 

Value
 

Column Value and then select the Pool ID column
 

14. Select the Hidden check box for all the rows.
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15. Clear the Optional check box for all the rows.
16. Click Options.
17. In the Action Options dialog box, select the Open In New Window check box.
18. Click OK to close the Action Options dialog box.
19. Click OK to close the Create New Action dialog box.
20. Click OK to close the New Action Link dialog box.
21. In the Column Properties dialog box of the Pool ID column, click the Data Format tab.
22. Select the Override Default Data Format check box and then specify the value for Treat Number As field as

Number.

Note:  You need to override the default data format only for the Pool ID column.

23. Click OK to close the Column Properties dialog box.

Dispose Talent Pools Data  
To meet data protection requirements, as administrators you might need to dispose talent pool data of terminated
employees. You can do this in the Data Exchange work area.

You first need to use the Configure Person Information Removal Policies task to create configuration templates. You
can create a template to remove person information of people who are part of a talent pool in any of these roles:

• Member

• Pool owner

You then need to enable the template and run the Remove Person Information task.

Create Configuration Template
1. Go to the Data Exchange work area in My Client Groups.
2. In the Remove Person Information section, click Configure Person Information Removal Policies.
3. Click Create to create a template.
4. Specify values for these fields.

Field Description

Name Template name

Code The template code, defaults to the name of the template.
 

Category Business object category. Select Worker.

Description A suitable description to identify the template.

5. Click OK.
6. Ensure that you're on the Components tab.
7. In the Business Objects pane, select Talent Pool.
8. In the Components pane, expand Talent Pool.
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9. Select any of these check boxes according to the role of the persons whose information you want to remove.

Check box Role of person to remove

Talent Pool Member Member of a talent pool
 

Talent Pool Owner Owner of a talent pool

10.Click Save and Close.
11. Enable the template.

Results:
Here’s what happens after the person information removal process of the Talent Pool object completes successfully:

• The terminated workers are removed from all talent pools in which they were members.

• The terminated workers are removed from all talent pools in which they were owners, even if they were the sole
owner.

What to do next
If the removed terminated workers were the only owners of a talent pool, you need to add a new owner either as a super
user or by using HCM Data Loader.

Related Topics
• Remove Person Information
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11  Personalization Using Transaction Design
Studio

Use Transaction Design Studio to Configure Field
Displays  
Use the Transaction Design Studio (TDS) to configure transactions and pages for responsive applications. TDS is
available within the HCM Experience Design Studio.

You can control the visibility of attributes that are displayed either as Delivered or Enabled, and the availability of fields
and sections of a transaction based on the user's role, person's business unit, or legal employer.

By default, the responsive pages display the often used attributes and hide the less often used attributes. Use Page
Composer to personalize the responsive pages and display the attributes and tabs delivered within the feature.

Here's how you start HCM Experience Design Studio:

1. Sign in to the application as Human Capital Management Application Administrator with Access HCM Page
Configurator (HRC_ACCESS_HCM_TRANSACTION_CONFIGURATOR_PRIV) privilege. This privilege provides
you access to TDS in HCM Experience Design Studio.

2. Enable a sandbox to compose data for configuring business objects. On the Home page, click the HCM
Experience Design Studio quick action under the My Client Groups tab.

3. Under Settings and Actions, click Edit Pages.
4. Select the site layer and click OK.

Related Topics
• Overview of Page Modification

How You Configure Talent Review Pages Using
Transaction Design Studio  
Use Transaction Design Studio (TDS) to create rules to configure Talent Review pages. You can include or hide sections
and fields as needed by your organization.

Actions
This table shows the actions that you can use to configure Talent Review pages and the page for which the action
applies.

Action Page

Prepare Review Content Prepare Review Content
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Action Page

  

Talent Review Meetings Create and Edit Talent Review Meeting pages

Talent Review Notes
 

Notes
 

Did you know that you can create multiple rules for an action? But remember that you can have only one active rule for
any action at a time.

Prepare Review Content Action
To control the attributes that meeting reviewers can see while preparing review content, create a rule for the Prepare
Review Content action in TDS. You can specify a role criteria for the rules that you create using this action.

You can specify the guided journey tasks to show at the page level and for the Meeting Info and Ratings sections of the
Prepare Review Content page in the Show or Hide Regions section.

You can hide or display these attributes in the Page Attributes section:

• The photo of the employee being reviewed

• Data submission deadline

• Data validity guideline

• The Display list of values used to filter the employees listed

• Meeting date

• Meeting instructions

• View Notes action for the employee in the Ratings section

• View Tasks action for the employee in the Ratings section

In the Available Attributes section, you can hide or display the name of the employee's manager.

Talent Review Meetings Action
To configure the fields shown on the Create and Edit Talent Review Meeting pages, use the Talent Review Meetings
actions in TDS and add a rule. This table lists the attributes of the Meeting data source.

Attribute Field on the Create and Edit
Talent Review Meeting pages

Make Required/ Not Required Make Visible/Not Visible

Data Submission Deadline Data Submission Deadline field in
the Meeting Info section

Yes Yes

Data Validity Guideline Data Validity Guideline field in the
Review Content section

Yes Yes

Find Workers by Analysis Option Find by analysis option in the
Employees to Include list of the
Population Selection section

No Yes
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Attribute Field on the Create and Edit
Talent Review Meeting pages

Make Required/ Not Required Make Visible/Not Visible

Find Workers by Criteria Option Find by criteria option in the
Employees to Include list of the
Population Selection section

No Yes

Find Workers in Talent Pool Option Find in talent pool option in the
Employees to Include list of the
Population Selection section

No Yes

Meeting Instructions Meeting Instructions field in the
Review Participants section

Yes Yes

Meeting Purpose Meeting Purpose field in the
Meeting Info section

Yes Yes

If your organization uses only some options in the Employees to Include list, you can hide the options that aren’t used.
If you hide 2 options in the Employees to Include list, the list is disabled and facilitators can see only the attributes
corresponding to the visible option when they configure a Talent Review meeting.

Talent Review Notes Action
The Notes page of a Talent Review meeting has two sections: Meeting Notes and Review Population Notes. To hide or
display these sections of the Notes page, create a rule for the Talent Review Notes action in TDS and then specify the
visibility for the corresponding attributes. You can specify a role criteria for the rules that you create using this action.

Related Topics
• HCM Experience Design Studio

How You Configure Succession Plan Pages Using
Transaction Design Studio  
Use the Succession Plans action in Transaction Design Studio to create rules to configure Oracle Fusion Cloud
Succession Management pages.

When you create rules using the Succession Plans action, you can do these tasks:

• Specify a role criteria.

• Hide or show fields.

• Mark some fields as required to be filled.

For example, your organization might not want private succession plans. You can create a rule for the Succession Plans
action and then hide the Private check box.

Available Attributes Region
To configure the succession plan page, you select a data source and then configure the attributes.

This table lists the attributes for the Plan Info data source.
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Attribute Field or Section on Succession
Plan Page

Make Required/ Not Required Make Visible/Not Visible

AI Suggested Candidates Suggested Candidates option of
the Add menu in the Candidates
section

No Yes

Add Talent Pool Members Talent Pool Members option in
the Add menu in the Candidates
section

No Yes

Add to Talent Pool
 

Check boxes and Add to Talent
Pool button for adding selected
candidates as talent pool members
 

No
 

Yes
 

Alerts
 

Alerts section
 

No
 

Yes
 

Banner for Incumbent Changing
Role
 

The banner shown in the Plan Info
section when the plan incumbent's
role changes
 

Note:
Applies only for Incumbent type
succession plans
 

No
 

Yes
 

Best-Fit Candidates
 

Option to select Best-Fit
candidates in the Add menu in the
Candidates section
 

No
 

Yes
 

Business Unit
 

Business unit for which the
succession plan is created
 

Yes
 

Yes
 

Created By
 

Created By
 

Note:
This field isn't visible by default.
 

No
 

Yes
 

Creation Date
 

Creation Date
 

Note:
This field isn't visible by default.
 

No
 

Yes
 

Department
 

Department for which the
succession plan is created
 

Yes
 

Yes
 

Description
 

Description
 

Yes
 

Yes
 

Estimated Remaining Months
 

Estimated Remaining Months
field for the plan incumbent

Yes
 

Yes
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Attribute Field or Section on Succession
Plan Page

Make Required/ Not Required Make Visible/Not Visible

 

Note:
• Applies only for Incumbent

type succession plans

• This field isn't visible by
default.

External Candidate
 

Add menu option for adding
external candidates
 

No
 

Yes
 

Impact of Loss
 

Impact of Loss field for the plan
incumbent
 

Note:
• Applies only for Incumbent

type succession plans

• This field isn't visible by
default.

Yes
 

Note:
Only users who can edit the
impact of loss value see the
Required indicator.
 

Yes
 

Incumbent Department
 

Department of the succession
plan's incumbent
 

Note:
Applies only for Incumbent type
succession plans
 

No
 

Yes
 

Incumbent Job
 

Job of the succession plan's
incumbent
 

Note:
Applies only for Incumbent type
succession plans
 

No
 

Yes
 

Incumbents
 

Incumbents section of the
succession plan
 

No
 

Yes
 

Job Grade
 

Job grade for which the succession
plan is created
 

Yes
 

Yes
 

Plan Info Descriptive Flexfields
 

Descriptive flexfields in the Plan
Info section
 

No
 

Yes
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Attribute Field or Section on Succession
Plan Page

Make Required/ Not Required Make Visible/Not Visible

Note:
These descriptive flexfields
aren't visible by default.
 

Privacy
 

Private check box
 

No
 

Yes
 

Reason for Departure
 

Reason for Departure field for the
plan incumbent
 

Note:
• Applies only for Incumbent

type succession plans

• This field isn't visible by
default.

Yes
 

Yes
 

Risk of Loss
 

Risk of Loss field for the plan
incumbent
 

Note:
• Applies only for Incumbent

type succession plans

• This field isn't visible by
default.

Yes
 

Note:
Only users who can edit the risk
of loss value see the Required
indicator.
 

Yes
 

Send alerts when candidates move
to roles that are different from the
plan role
 

Check box in the Alerts section
 

No
 

Yes
 

Send alerts when candidates move
to the plan role
 

Check box in the Alerts section
 

No
 

Yes
 

Send alerts when the incumbent
changes roles
 

Check box in the Alerts section
 

No
 

Yes
 

To configure the Candidates section of the succession plan, select the Candidates data source. This table lists the
attributes for the Candidates data source.

Attribute Field or Section on Succession
Plan Page

Make Required/ Not Required Make Visible/Not Visible

All Other Plans
 

Count of all other succession plans
that the person is also a candidate
in
 

No
 

Yes
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Attribute Field or Section on Succession
Plan Page

Make Required/ Not Required Make Visible/Not Visible

Note:
This field isn't visible by default.
 

All Other Plans Link
 

Count link that opens a page that
lists all other succession plans that
the person is also a candidate in
 

No
 

Yes
 

Banner for Candidate Changing
Role
 

Banner shown for a candidate
when the candidate's role changes
to a role different from the plan
role
 

No
 

Yes
 

Banner for Candidate Moving to
Incumbent Role
 

Banner shown for a candidate
when the candidate's role changes
to the incumbent's role
 

No
 

Yes
 

Candidate Since Field that shows the date the
candidate was added to the
succession plan

No Yes

Impact of Loss
 

Impact of Loss field for the
candidate
 

Note:
This field isn't visible by default.
 

Yes
 

Note:
Only users who can edit the
impact of loss value see the
Required indicator.
 

Yes
 

Interim Successor
 

A label that identifies the candidate
as an interim successor
 

No
 

Yes
 

Job
 

Candidate's job
 

No
 

Yes
 

Other Accessible Plans
 

Count of all other accessible
succession plans the person is a
candidate in
 

No
 

Yes
 

Other Accessible Plans Link
 

Count link that opens a page that
lists all other accessible succession
plans that the person is also a
candidate in
 

No
 

Yes
 

Plan Candidates Descriptive
Flexfields
 

Descriptive flexfields of the
Candidates section of the
succession plan
 

No
 

Yes
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Attribute Field or Section on Succession
Plan Page

Make Required/ Not Required Make Visible/Not Visible

Note:
These descriptive flexfields
aren't visible by default.
 

Ranking
 

Candidate's ranking
 

Yes
 

Yes
 

Readiness
 

Candidate's readiness level
 

Yes
 

Yes
 

Risk of Loss
 

Risk of Loss field for the candidate
 

Note:
This field isn't visible by default.
 

Yes
 

Note:
Only users who can edit the risk
of loss value see the Required
indicator.
 

Yes
 

Status
 

Candidate's status
 

No
 

Yes
 

Willing to Relocate
 

Candidate's willingness to relocate
 

Note:
This field isn't visible by default.
 

No
 

Yes
 

Related Topics
• HCM Experience Design Studio

How You Configure Talent Pool Pages Using Transaction
Design Studio  
Use the Talent Pools action in Transaction Design Studio (TDS) to create rules to configure Talent Pool pages as needed
by your organization.

When you create rules using the Talent Pools action, you can do these configurations:

• Specify the role criteria.

• Show or hide fields.

• Mark some fields as required to be filled.

When you create a rule for the Talent Pools action, in the Available Attributes section, you select the data source and
then configure the attributes.
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Pool Info Data Source Attributes
You select the Pool Info data source to configure the Pool Info and Development Goals sections of the talent pool.

This table lists the attributes for the Pool Info data source.

Attribute Field on Talent Pool Page Make Required/ Not Required Make Visible/Not Visible

Add Development Goal
 

Add button for adding a
development goal to the talent
pool
 

No
 

Yes
 

Best-Fit Members
 

Best-Fit Members option in the
Add menu of the Members section
 

No
 

Yes
 

Business Unit
 

Business unit for which the talent
pool is created
 

Note:
This field isn't visible by default.
 

Yes
 

Yes
 

Department
 

Department for which the talent
pool is created
 

Note:
This field isn't visible by default.
 

Yes
 

Yes
 

Description
 

Description
 

Yes
 

Yes
 

Development Goal Assignment
Process Message

The message that displays the
process ID of the process that's
scheduled when user clicks the
Assign Goals to Members button
in the Development Goals section

No Yes

Development Goals Section
 

The section in the talent pool for
adding or viewing development
goals
 

No
 

Yes
 

Job
 

Job for the talent pool
 

Note:
This field isn't visible by default.
 

Yes
 

Yes
 

Job Family
 

Job family for which the talent pool
is created
 

Yes
 

Yes
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Attribute Field on Talent Pool Page Make Required/ Not Required Make Visible/Not Visible

Note:
This field isn't visible by default.
 

Job Grade
 

Job grade for which the talent pool
is created
 

Note:
This field isn't visible by default.
 

Yes
 

Yes
 

Pool Info Descriptive Flexfields
 

Descriptive flexfields in the Pool
Info section of the talent pool
 

Note:
These flexfields aren't visible by
default.
 

No
 

Yes
 

Position
 

Position
 

Note:
This field isn't visible by default.
 

Yes
 

Yes
 

Remove Development Goal
 

Remove icon for a development
goal
 

No
 

Yes
 

Members Data Source Attributes
You select the Members data source in the Available Attributes section to configure the Members section of the talent
pool page.

This table lists the attributes for the Members data source.

Attribute Field on Talent Pool Page Make Required/ Not Required Make Visible/Not Visible

Impact of Loss
 

Impact of Loss
 

Note:
This field isn't visible by default.
 

Yes
 

Yes
 

Job
 

Member's job
 

No
 

Yes
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Attribute Field on Talent Pool Page Make Required/ Not Required Make Visible/Not Visible

Member Since
 

Field that shows the date the
member was added to the talent
pool
 

No
 

Yes
 

Pool Members Descriptive
Flexfields
 

Descriptive flexfields in the
Members section of the talent pool
 

Note:
These flexfields aren't visible by
default.
 

No
 

Yes
 

Risk of Loss
 

Risk of Loss
 

Note:
This field isn't visible by default.
 

Yes
 

Yes
 

Status
 

Member's status
 

No
 

Yes
 

Willing to Relocate
 

Member's willingness to relocate
 

Note:
This field isn't visible by default.
 

No
 

Yes
 

Pool Member List Data Source Attributes
You select the Pool Member List data source in the Available Attributes section to configure the Members section of
the Add from Talent Pool page. This page opens when candidate managers select the Talent Pool Members option in
the Add menu of the Candidates section of a succession plan.

This table lists the attributes for the Pool Member List data source. You can set the value of these attributes to Visible
or Not visible according to your organization's requirements.

Attribute Field shown on Add from Talent Pool Page

Business Unit
 

Business unit of the member
 

Grade
 

Member's grade
 

Manager Manager of the member

Member Since
 

The date the member was added to the talent pool
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Attribute Field shown on Add from Talent Pool Page

Note:
This field isn't visible by default.
 

Status
 

Member's status
 

Related Topics
• HCM Experience Design Studio

Configure Guided Journeys for Talent Review Meeting
Configuration Pages  
Support facilitators while they configure a Talent Review meeting by providing guidance such as tutorials, company
policies, and best practices.

Before you start

First, you need to configure guided journey tasks for Oracle Fusion Cloud Talent Review. Use the Guided Journey
category in Checklist Templates to set up and add tasks that are relevant for the guided journeys for Oracle Talent
Review.

As administrators, you need to enable guided journeys on Oracle Talent Review meeting configuration pages using
Transaction Design Studio (TDS). You can enable the guided journeys at both the page and page section level.

Here's what to do

1. Select the Talent Review Meetings action in TDS and add a rule.
2. In the Show or Hide Regions section, configure the guided journeys for page and page section level. Edit the region.

Search and select the associated guided journey and the tasks to show for the region.
3. Save your changes.

Results:

Users can see a Guide Me button after you enable a guided journey for the page section or page.

Related Topics
• Use Transaction Design Studio to Configure Field Displays

• Overview of Journeys
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Configure Guided Journeys for the Prepare Review
Content Page  
Support reviewers when they prepare review content by providing guidance such as tutorials, company policies, and
best practices.

Before you start

First configure guided journey tasks. Use the Guided Journey category in Checklist Templates to set up and add tasks
that are relevant for managers who prepare review content.

As administrators, you enable guided journeys on the Prepare Review Content page using Transaction Design Studio
(TDS). You can enable the guided journeys at both the page and page section level.

Here's what to do

1. Select the Prepare Review Content action in TDS and add a rule.
2. In the Show or Hide Regions section, configure the guided journeys for page and page section level. Edit the region.

Search and select the associated guided journey and the tasks to show for the region.
3. Save your changes.

Results:

Managers can see a Guide Me button after you enable a guided journey for the page section or page.

Related Topics
• Use Transaction Design Studio to Configure Field Displays

• Overview of Journeys
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